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SUMMARY
Phagocytosis, signal transduction, and inflammatory responses require changes in lipid metabolism. Perox-
isomes have key roles in fatty acid homeostasis and in regulating immune function. We find that Drosophila
macrophages lacking peroxisomes have perturbed lipid profiles, which reduce host survival after infection.
Using lipidomic, transcriptomic, and genetic screens, we determine that peroxisomes contribute to the cell
membrane glycerophospholipid composition necessary to induce Rho1-dependent signals, which drive
cytoskeletal remodeling during macrophage activation. Loss of peroxisome function increases membrane
phosphatidic acid (PA) and recruits RhoGAPp190 during infection, inhibiting Rho1-mediated responses.
Peroxisome-glycerophospholipid-Rho1 signaling also controls cytoskeleton remodeling in mouse immune
cells. While high levels of PA in cells without peroxisomes inhibit inflammatory phenotypes, large numbers
of peroxisomes and low amounts of cell membrane PA are features of immune cells frompatients with inflam-
matory Kawasaki disease and juvenile idiopathic arthritis. Our findings reveal potential metabolic markers
and therapeutic targets for immune diseases and metabolic disorders.
INTRODUCTION

Metabolic and immune response pathways are intimately inter-

twined (Ferrante, 2013; Lee et al., 2018; Musselman et al.,

2017; Zmora et al., 2017). Recent evidence has revealed a wider

role for metabolic networks during development, activation, and

regulation of distinct immune effector functions of different im-

mune cell lineages (Kominsky et al., 2010; O’Neill and Pearce,

2016; Teng et al., 2019; Pearce and Pearce, 2013; Zhang et

al., 2017). Lipids in particular have emerged as important factors

in immunity. Both innate and adaptive immune cells undergo

changes in lipid metabolism in response to infection (Hubler

andKennedy, 2016). For example, macrophage lipidmetabolism

is rapidly reprogrammed during infection to support an array of

immune functions, such as phagocytosis and secretion of proin-

flammatory cytokines (Hubler and Kennedy, 2016).

Themetabolism of fatty acids (FAs) is amajor source of biolog-

ical lipids that form cell membranes and regulate inflammatory
This is an open access article under the CC BY-N
processes (Dowds et al., 2014; Hubler andKennedy, 2016; Sadik

and Luster, 2012). FAs are precursors to phospholipids (PLs)

such as glycerophospholipids (GLs) and sphingolipids (SLs), tri-

glycerides (TAGs), and eicosanoids, which have pivotal roles in

the activation and function of macrophages, invariant natural

killer T (iNKT) cells, and other T cells. PLs contribute to the forma-

tion of membrane domains where cell receptors mediate signal

transduction and regulate membrane trafficking (Levin et al.,

2017; O’Donnell et al., 2018; Yang et al., 2018). Dysregulated

lipidmetabolismmay underlie the immune cell dysfunction of im-

mune disorders, as evidenced by the roles of macrophages in

atherosclerosis (Di Gioia et al., 2020; Palsson-McDermott and

O’Neill, 2020; Remmerie and Scott, 2018). Despite recent recog-

nition of the importance of lipid metabolism in immunity, the

regulation of distinct lipid changes in the activation or inhibition

of specific pathways in immune cells remains poorly understood.

Peroxisomesareorganelles that regulate thesynthesis and turn-

over of complex lipids, including the b-oxidation of very-long chain
Cell Reports 38, 110433, March 1, 2022 ª 2022 The Author(s). 1
C-ND license (http://creativecommons.org/licenses/by-nc-nd/4.0/).
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FAs, the synthesis of ether lipids, and the a-oxidation of branched

chain FAs (Schrader and Fahimi, 2006; Wanders and Waterham,

2006). Previous work has suggested that peroxisomes are pivotal

to signaling networks that govern immune cell activation and func-

tion inDrosophila (Di Cara et al., 2017),mouse (DiCara et al., 2017;

Eguchi et al., 1979; Facciotti et al., 2012; Vijayan et al., 2017), and

human (DiCaraetal., 2019a;Dixit et al., 2010;Gilchrist etal., 1974).

In particular, previous reports have shown a direct role for peroxi-

somes in macrophage-mediated phagocytosis (Stroschein-Ste-

venson et al., 2006; Di Cara et al., 2017), as well as a requirement

for peroxisomes in the release of antimicrobial peptides bymacro-

phages in response to bacterial pathogen-associated molecular

patterns (Di Cara et al., 2017). Common to these immune re-

sponses is the role of the cytoskeleton. Defects in cytoskeleton re-

modeling impact essential immune events such as inflammatory

cytokine secretion and phagocytosis, which ultimately decrease

the ability of an animal to survive bacterial infection. These findings

led us to hypothesize that cytoskeletal defects observed in perox-

isome-deficient cells are due to a breakdown inperoxisomemeta-

bolism and that peroxisome-derived lipid metabolites regulate

cytoskeleton-mediated immune responses.

We investigated how peroxisome-mediated lipid metabolism

influences macrophage function to better understand the meta-

bolic pathways that control immune cell activity. Given the

conserved central role for peroxisomes in lipid metabolism

across phyla, we investigated how peroxisome lipid metabolism

regulates signals that engage inflammatory and immune re-

sponses in Drosophila plasmatocytes, a cell population consid-

ered the fly equivalent of mammalian macrophages (Cherry,

2008; Lemaitre and Hoffmann, 2007; Parsons and Foley, 2016;

Rizki and Rizki, 1980). We found that a lack of functional perox-

isomes in plasmatocytes altered the amount and cellular distri-

bution of distinct GLs during plasmatocyte immune activation

in Drosophila and confirmed these findings in murine macro-

phages. Specifically, we observed that defects in peroxisomal

b-oxidation disrupted the lipid milieu necessary for proper

cytoskeletal remodeling during bacterial challenge. Given the

profound effects of inhibiting these pathways in models of auto-

immune disorders, our study regards the peroxisome as an

organelle that is unexplored as a therapeutic target for the treat-

ment of immune and infectious diseases.

RESULTS

Changes in the profile of cellular lipids during infection
require peroxisome metabolism
To determine whether peroxisome lipid metabolism contributes

to signaling pathways during immune defense, we surveyed the
Figure 1. Systems biology analyses showperoxisome-dependent contr

(A) Schematic for peroxisome-dependent lipids and RNA-seq-based changes in

(B) Lipidomic analysis of control S2 cells (CTL) in mock-treated versus Ecc15-in

versus infected Pex5-i cells. Values are shown as relative log2 fold-changes. Lipi

means. Each dot represents a lipid species. Dot size indicates statistical signific

(C) Comparison of the ratios between the abundance of a chosen lipid species a

experiments and are shown as means ± SD. Significance was determined using

(D) Gene interaction network of KEGG terms positively or negatively enriched in Pe

of circle). Red and blue indicate positive and negative KEGG terms, respectively
global lipid profile of peroxisome-deficient Schneider 2 cells (S2

cells) (Schneider, 1972) during infection. We analyzed S2 cells

depleted of Peroxin5 (Pex5-i cells), the receptor required for

the import of most proteins into the peroxisomal matrix (Smith

and Aitchison, 2013), that have defects in peroxisome biogen-

esis and function (Di Cara et al., 2019b; Klein et al., 2001) (Fig-

ure 1A). We probed the lipid profiles of wild-type S2 cells

(CTLs) and Pex5-i cells mock-treated or infected with a patho-

genic bacterium, Erwinia corotorova corotorova (Ecc15) (Basset

et al., 2000) (Figure 1A). The analysis identified 893 species of the

PL and glyceride classes (Figure 1B, Table S1). When the lipid

profiles of CTLs exposed to Ecc15 were compared with those

of uninfected CTLs, 79% of the 893 identified lipid species

changed in amount (Figure 1B, Table S1). Moreover, 72% and

84% of the 893 lipids identified showed changes in amount

when CTLs were compared with Pex5-i cells under uninfected

or Ecc15-infected conditions, respectively (Figure 1B, Table

S1). Therefore, S2 cells change their lipid milieu during infection,

and some of the changes depend on peroxisomes. Previous

studies have reported that cells with dysfunctional peroxisomes

have high amounts of glycerides and phosphatidylethanol-

amines (PEs) with fatty acyl chain lengths of >40 carbon atoms

(Herzog et al., 2016). Our screen revealed that Pex5-i cells had

increased TAGs and PEs with very-long chain FAs (Figure S1A,

Table S1), confirming the robustness of this method in identifying

lipid changes in cells of the two genotypes.

To identify which changes in lipid species were modulated

during infection, we grouped all lipid species identified into clas-

ses and compared the lipid profiles of CTLs exposed to Ecc15 to

uninfected CTLs. Our analysis revealed changes in the amounts

in the phosphatidylinositol (PI), phosphatidylserine (PS), phos-

phatidylglycerol (PG), ceramide (Cer), TAG, and diacylglyceride

(DAG) classes (Figure 1B).

We next determined which classes of lipids induced during

infection changed in amount following depletion of peroxisomal

metabolism.Wecompared the lipidprofilesof infectedPex5-i cells

to infected CTLs. The overall comparison illustrated in the bubble

graphs (Figure1B) showedchanges in theamountsof lipid classes

that are key components of the plasmamembrane and involved in

cellular signaling, i.e., GLs such as PA, phosphatidylcholine (PC)

and PI, sphingolipids (SLs) such as Cer, and glycerides such

as DAG. Notably, these lipids were either unchanged or changed

in a different direction and/or to a different degree when we

compared theprofilesof uninfectedPex5-i cells andCTLs (Figures

1B and 1C), suggesting that peroxisomal metabolism participates

in defining the distinct lipid milieu of infected cells.

Plotting the abundance of each lipid class normalized to the

abundance of internal standards in all sample groups, we found
ibutions tometabolic and cellular signaling during bacterial infection

gene expression during infection.

fected conditions, mock-treated CTLs versus Pex5-i cells, and infected CTLs

domics data were from four independent experiments and are represented as

ance.

nd the abundance of internal lipid standards. Data are from four independent

Student’s t test. ***p < 0.001; **p < 0.01; *p < 0.05; ns, not significant.

x5-i cells relative to CTLsmock-treated (right side of circle) or infected (left side

. Color intensity indicates degree of enrichment. See also Figure S1.
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that during infection, CTLs have increased amounts of PI and PS,

while Pex5-i cells showed decreases in PI and PS and increases

in PC, PA, Cer, TAG, and DAG (Figure 1C). We calculated Z

scores for all 893 identified lipids to establish thresholds of sig-

nificance for the lipid species reported in Figure 1B that accumu-

lated or decreased in a peroxisome-dependent manner during

infection. Our Z scores showed that all lipid species belonging

to the PA and PG lipid classes were elevated in infected Pex5-i

cells compared with infected CTLs, with PA (36:2), PC (26:2),

and PG (30:0 and 32:0) among the most significantly elevated

lipid species (Figures S1B and S1C). In contrast, nearly all PI

and PS lipid species were lower in amount in infectedPex5-i cells

comparedwith infected CTLs, with PI (34:6) and PS (36:2) among

the most significantly reduced lipid species (Figures S1B and

S1D).

Our findings suggest that peroxisome function is important to

generate a specific cellular milieu of lipids that supports cellular

responses to infection.

Peroxisomes support metabolic responses to mediate
immune signaling
To determine the metabolic signaling that supports immune

pathway activation in response to microbial infection, we carried

out genome-wide transcriptional profiling of CTLs and Pex5-i

cells either mock-treated or Ecc15-infected cells. We identified

327 genes upregulated and 389 genes downregulated (p <

0.05) in mock-treated Pex5-i cells compared with CTLs, and

393 genes upregulated and 353 genes downregulated (p <

0.05) in Ecc15-infected Pex5-i cells compared with Ecc15-in-

fected CTLs (Table S2). Gene network analysis of the processes

and pathways enriched from differentially expressed genes of

infected Pex5-i cells comparedwith infectedCTLswere overrep-

resented among gene sets belonging to lipid metabolic pro-

cesses, including the metabolism of FAs, membrane lipids,

and phospholipids, as well as other metabolic processes such

as carbohydrate and polysaccharide biosynthesis (Figure 1D).

These data are in agreement with the findings of a study that

found increased carbohydrate and purine metabolism in

response to peroxisome dysfunction in Drosophila and mouse

(Wangler et al., 2017), and some components of these pathways

were also enriched when CTLs were compared with uninfected

Pex5-i cells (Figure 1D). Other genes were strongly enriched in

the master cellular regulatory signaling of immunity (e.g., regula-

tors of stress response pathways and innate immune response

pathways), growth control cell signaling pathways (e.g., Tor

pathway, Hippo signaling), and cytoskeleton remodeling (e.g.,

Rho GTPases) (Figure 1D, Table S2). These results suggest

that peroxisomes are required for regulation of phospholipid

metabolic pathways, immune pathways, stress response path-

ways, and cytoskeleton remodeling during infection (Figure 1D).

Indeed, these functions were either not enriched or differentially

enriched when we compared the gene expression profiles of

mock-treated Pex5-i cells to those of CTLs (Figure 1D). In partic-

ular, lipid metabolic genes and stress response signaling genes

were differentially enriched between mock-treated and Ecc15-

infected conditions. Cytoskeleton regulatory genes were nega-

tively enriched between uninfected cells of the two genotypes,

while they were positively enriched during infection. Of the
4 Cell Reports 38, 110433, March 1, 2022
2,514 genes upregulated in infected CTLs versus uninfected

CTLs, 1,232 were downregulated (505 genes) or unchanged

(727 genes) in infected Pex5-i cells compared with infected

CTLs. Of the 1,610 genes downregulated in infected versus un-

infected CTL cells, 179 genes were instead upregulated in in-

fected Pex5-i cells (Figure S1E). Pearson correlation analysis

identified transcript changes in Pex5-i cells that negatively corre-

lated to profiles observed in CTLs during infection (Figure S1F).

In this group, we identified genes that are involved in GL meta-

bolism (Figure S1G), reinforcing data from the lipidomic analysis

showing that depletion of peroxisome activity impacts the GL

milieu required during infection.

Pex1 mutant S2 cells show metabolic and immune
defects observed in Pex5-i cells
To verify that the changes in lipid metabolic pathways observed

in infected Pex5-i cells were not the result of Pex5 mutation per

se but were the result of overall peroxisomal dysfunction, we

made a CRISPR/Cas9 mutant S2 cell line (Bassett et al., 2014)

deleted for the Peroxin1 (Pex1) gene. Pex1 codes for a member

of the AAA-family of ATPases and mediates protein import into

peroxisomes through its recycling of the Pex5 receptor (Smith

and Aitchison, 2013). Mutation of Pex1 renders peroxisomes

nonfunctional (Mast et al., 2011; Walter et al., 2001). The Pex1

mutant cell line (Pex1 cells) does not express Pex1 mRNA (Fig-

ure S2A). GFP fused to the peroxisome targeting signal type 1

(PTS1) serine-lysine-leucine-CO2H (GFP-SKL) labeled peroxi-

somes in CTLs and Pex1 cells. Pex1 cells showed defects in

peroxisome protein import, since GFP-SKL was cytosolic in

these cells (Figure S2B). Peroxisome protein import was rescued

when we transfected Pex1 cells with wild-type (WT) Pex1 cDNA

as shown by GFP-SKL localization to puncta characteristic of

peroxisomes (Figure S2B). Pex5-i cells exhibit defects of the

cortical actin cytoskeleton in S2 cells andDrosophila primary im-

mune cells (Di Cara et al., 2017). Pex1 cells also showed defects

in cortical actin organization (Figure S2B). Expression of WT

Pex1 cDNA in Pex1 cells restored actin organization (Figure S2B)

and cell area (Figure S2C), whose extent is dependent on the or-

ganization of the cytoskeleton, to what was observed in CTLs

(Figures S2B and S2C).

CTLs infected with Ecc15 showed increased expression of the

antimicrobial peptide gene Dpt (Figure 2A) (Basset et al., 2000),

while infected Pex1 cells showed no induction ofDpt expression,

confirming the peroxisome requirement for immune signaling

activation (Di Cara et al., 2017). Moreover, flow cytometry (FC)

showed that the uptake of E. coli by Pex1 cells was reduced

compared with CTLs (Figure S2D).

Transcriptional analysis identified significant dysregulation of

key phospholipid metabolic pathway enzymes in Pex1 cells

during infection (Figure 2A), as was also observed in the tran-

scriptomic analysis of Pex5-i cells (Figure S1G). Specifically,

phosphatidylserine synthase (CG4825) (Valadas et al., 2018),

phosphatidylinositol synthase (Pis) (Laurinyecz et al., 2016),

CDP-diacylglycerol synthase (CdsA) (Volta et al., 1999), diacyl-

glycerol kinase (DGK) (Wightman et al., 2012), and Lipin (Schmitt

et al., 2015) were dysregulated in infected Pex1 cells (Figures 2A

and 2B). Additionally, we assayed the gene expression levels of

key enzymes of the sphingolipid metabolic pathway, such as
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ceramidase (CDase) (Yuan et al., 2011), which converts ceram-

ides (Cer) to complex sphingolipids (Acharya and Acharya,

2005), and ceramide kinase (Cerk) (Dasgupta et al., 2009), which

catalyzes the phosphorylation of Cer to Cer-1p, and observed

that these genes were differentially expressed in infected Pex1

cells compared with infected CTLs (Figure 2A). Together, these

data demonstrate that Pex1 cells mirror infected Pex5-i cells in

their altered expression of phospholipid metabolic genes.

Because Pex1 showed greater phenotypic expressivity and

penetrance than the RNAi-mediated Pex5 depletion, we used

Pex1 cells for all subsequent investigations.

Peroxisome depletion affects the amounts and
distributions of distinct glycerophospholipids
Our lipidomic and transcriptomic analyses indicated that perox-

isomes regulate the GLmilieu during infection. We have reported

that peroxisome-depleted cells show cortical actin cytoskeleton

defects (Di Cara et al., 2017). GLs are key components of the cell

membrane, and their localization to distinct membranes in mac-

rophages promotes cytoskeleton remodeling that supports re-

sponses to immune stimuli. Upon infection, PIs, i.e., PI(4,5)P2

(PIP2), and PI(3,4,5)P3 (PIP3), and PS accumulate at the cell

membrane, where they support the assembly of mediators of im-

mune cell activation (Aderem and Underhill, 1999; Burkhardt,

2013; Flannagan et al., 2012; Lacy and Stow, 2011; Murray

and Stow, 2014; O’Donnell et al., 2018). PIs and PS decreased,

while their precursors PA and DAG increased in cells lacking

functional peroxisomes relative to CTLs during infection (Fig-

ure 2B). To determine whether lack of peroxisome function af-

fects the distribution of these deregulated GLs, we monitored

the distribution of PS, PIP2, and PIP3 in uninfected and infected

CTLs and Pex1 cells. We visualized the distribution of PIP2 by

immunofluorescence (IF) labeling, and PIP3 and PS by the fluo-

rescent reporters GRP1-GFP and GFP-Lact-C2, respectively

(Khuong et al., 2010; Lai et al., 2013; Yeung et al., 2008). In un-

challenged conditions, PS, PIP2, and PIP3 were diffuse in the

cytoplasm of CTLs and Pex1 cells, both of which showed the

typically round profiles of unchallenged cells (Figures 2C–2E).

PS was found in the cytoplasm of infected Pex1 cells, but local-

ized to cell membrane protrusions in infected CTLs (Figure 2C).

In infected CTLs, PIP2 staining was stronger in intensity than in
Figure 2. Peroxisomes contribute to changes in glycerophospholipids

(A) Quantification of relative gene expression in CTLs and Pex1 cells after infecti

compared with the corresponding gene in mock-treated CTLs and Pex5-i cells,

(B) Pathway of selected metabolic steps in PI and PS metabolism. Boxes indic

compared with infected CTLs. Circles represent metabolites of the pathways that

screen during infection.

(C) Imaging of the Lac2-GFP reporter that detects PS. Green, PS reporter; red, a

(D) IF microscopy of PIP2. Red, PIP2; blue, DNA; green rods, E. coli. Arrowhead

(E) Imaging of the GRP1-GFP reporter to detect cellular PIP3. Green, PIP3 repor

(F) Quantification of PIP3.

(G) Imaging of PA reporter, PABD-RFP. Red, PA reporter; green, actin; red rods,

(H) Graphic reporting the percentage of cells with a specific lipid localized at the

(I) Quantification of PA in cytoplasmic and cell membrane fractions of cells of the

(J) Actin staining in cells of the indicated genotypes and under the indicated trea

(K) Histogram reporting the area of cells of the indicated genotypes and under the

independent experiments totaling 30 cells. Significance was determined using a tw

also Figure S2 and Videos S1–S4.
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infected Pex1 cells and was seen to concentrate in spots at

the cell edge (Figure 2D). PIP3 localized to cell membrane protru-

sions in infected CTLs but was restricted to the cytoplasm in in-

fected Pex1 cells (Figure 2E).

PIs are important signaling molecules, and synthesis of PIs

such as PIP3 has been linked to peroxisomemetabolism (Jeynov

et al., 2006). We measured PIP3 amounts in membrane and

cytoplasmic fractions of CTLs and Pex1 cells and confirmed

increased amounts of PIP3 in infected CTLs versus uninfected

CTLs, and that the amounts of PIP3 in Pex1 cell membranes

did not change in the presence or absence of E. coli (Figure 2F).

Differences in PIP3 amounts were not large between the cyto-

plasmic fractions of cells of both genotypes and under both con-

ditions. Live imaging of CTLs and Pex1 cells was used to

examine the dynamics of PIP3 reporter distribution to the cell

membrane protrusions 30–60 min after infection. The PIP3 re-

porter dynamically distributed to the sites where membrane pro-

trusions formed in infected CTLs (Video S1). In contrast, infected

Pex1 cells did not form protrusions, and the PIP3 reporter re-

mained in the cytoplasm of the still round cell (Video S2).

PA accumulates at the cell membrane in Pex1 cells and
causes cortical cytoskeleton defects
Lipidomic analysis ofPex5-i cells suggested that cells with defec-

tiveperoxisomesaccumulatePAand that defects associatedwith

this accumulation are exacerbated by infection (Figures 1C, S1B,

and S1C). We visualized the cellular distribution of PA by moni-

toring the location of a fluorescent PA reporter, PABD-RFP. In un-

infected CTLs, PABD-RFPwas foundmainly in the nucleus, while

in Pex1 cells PABD-RFP was also visible at the cell membrane

(Figure 2G). Nuclear localization of PABD reporters has been re-

ported for cells lacking PA at the plasma membrane (Nakanishi

et al., 2004). Infected Pex1 cells showed a uniform distribution

of PABD-RFP at the cell membrane, which was not observed in

infected CTLs (Figure 2G). Live imaging of CTLs and Pex1 cells

was done to examine the dynamics of PABD-RFP distribution

30–60 min after infection with E. coli. PABD-RFP accumulated in

the nucleus and cytoplasm but was not visible at membrane pro-

trusionsof infectedCTLs (VideoS3). In contrast, PABD-RFP local-

ized to cell membrane protrusions in infected Pex1 cells (Video

S4). Quantification of the fluorescence intensity of reporters at
during cell infection

on with Ecc15. Gene expression is reported for infected CTLs and Pex1 cells

respectively.

ate genes upregulated (green) or downregulated (red) in infected Pex5-i cells

were accumulated (green), reduced (red), or undetected (black) in the lipidomic

ctin; red rods, E. coli. Bar, 10 mm.

points to a concentration of PIP2. Bar, 10 mm.

ter; red, actin; red rods, E. coli. Bar, 10 mm.

E. coli.

membrane under uninfected and infected conditions.

indicated genotypes and conditions.

tments. Blue, DNA; red rods, E. coli; red, actin. Bar, 10 mm.

indicated conditions. Values in (H), (I), and (K) report the means ± SD of three

o-way ANOVA test. ****p < 0.0001; **p < 0.01; *p < 0.05; ns, not significant. See
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the edge/protrusions of cells and in the cytoplasm of cells of both

genotypes and under uninfected and infected conditions

confirmed that PS, PIP2, and PIP3 were in the cytoplasm of unin-

fected cells of both genotypes, and in themembrane of CTLs, but

notPex1cells,during infection (Figure2H). Incontrast,PABD-RFP

localizedmainly to thecellmembrane inPex1cells, especially dur-

ing infection (Figure 2H).

We measured PA amounts in membrane and cytoplasm frac-

tions from both CTLs and Pex1 cells under uninfected and in-

fected conditions. We found more PA in the membrane fraction

of uninfected Pex1 cells compared with that of uninfected CTLs,

and the increase in PA at the cell membrane was larger in Pex1

cells than in CTLs under infection (Figure 2I). Infected CTLs

treated with PA did not show a clear cortical actin network and

did not form protrusions, in contrast to what was observed in in-

fected Pex1 cells in the absence or presence of added PA (Fig-

ures 2J and 2K).

Weperformedgenetic interaction studies inS2cells todiscrim-

inate whether the cytoskeleton defects observed in Pex1 cells

were causedmainly by the accumulation of PAor by lowamounts

of PI. We tested if enzymes responsible for the biosynthesis of PI

influenced peroxisome-dependent actin remodeling during

infection. Overexpression (OE) of the Pis gene coding for the

enzyme involved in the last step of PI synthesis did not rescue

the defects in cortical cytoskeleton organization of infected

Pex1 cells (Figure 3A). Cytoskeleton remodeling-signaling is

controlled by PIP3, which is produced by the phosphorylation

of PIP2 by class I phosphoinositide 3-kinases (PI 3-kinases)

(Deane and Fruman, 2004; Heo et al., 2006; Juss et al., 2012; Re-

versi et al., 2014).Weoverexpressed thePI3K92Egene encoding

PI3-kinase92E in Pex1 cells to see if it could rescue the cortical

cytoskeleton defects observed during infection, but OE of

PI3K92E did not rescue these defects (Figure 3A). We then over-

expressed theCdsAgenecoding for theenzyme that convertsPA

to CDP-DAG, the substrate of Pis and an intermediate in the syn-

thesis of other GLs through the cytidine diphosphate diacylgly-

cerol pathway (Volta et al., 1999), in Pex1 cells. We observed

that OE of CdsA rescued the defects in actin organization and

membrane protrusions of infected Pex1 cells (Figure 3A). More-

over, when we depleted infected cells of CdsA, CdsA-i cells

showed defects similar to those observed inPex1 cells, including

abnormal organization of the cortical cytoskeleton and failure of

the cells to form membrane protrusions in response to infection

(Figure 3A). Additionally, OE of CdsA in Pex1 cells restored the

amounts of PA in the membrane to CTL levels (Figure 2I).

CdsA-i cells showed reduced engulfment of bacteria (Fig-
Figure 3. Defects in peroxisomal b-oxidation affect cytoskeleton remo

(A) Actin staining of cells of the indicated genotypes. Blue, DNA; red, actin; red r

(B) Survival of Hml > UAS-GFP control (Hml), Hml > Pex5-i, Hml > CdsA-I, and H

(C) Quantification of pathogen load as measured by CFUs formed by Ecc15.

(D) Survival of Hml > UAS-GFP (Hml) control, Hml > Pex5-i, Hml > DGK, Hml > Pe

Ecc15.

(E and F) Actin staining of cells of the indicated genotypes. Blue, DNA; red, actin

(G) Histogram reporting area of cells of the indicated genotypes and under the indi

(B) and (D) and for 30 cells in (G). Values reported are the means ± SD of four in

Significancewas determined using the KaplanMeier and log rank test in (B) and (D

***p < 0.001; ns, not significant. Black asterisks, significance compared with CTL

and S2.
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ureS2D), confirming that thedefects in thePAmetabolic pathway

impact cortical cytoskeleton remodeling, thereby affecting

immune cell activity. Pex1;CdsA-i cells showed reduced phago-

cytosis compared with Pex1 cells (Figure S2D), supporting the

idea that peroxisome activity acts upstream of CdsA in GL

metabolism.

To explore the immune requirement for CdsA during infection

in vivo, we modulated CdsA expression in plasmatocytes

(Drosophila adult macrophages) during septic infection of flies.

Adult flies with a targeted depletion of plasmatocyte CdsA

(Hml > CdsA-i) had problems surviving septic infection with

Ecc15. Similar to Hml > Pex5-i flies, 50% of the Hml > CdsA-i

flies died 4 days after infection, and 100% died after 8 days (Fig-

ure 3B). In addition, OE of CdsA in Hml > Pex5-i plasmatocytes

(Hml > Pex5-i;CdsA) improved the survival of Hml > Pex5-i flies

to septic infection (Figure 3B). Colony forming unit (CFU) analysis

showed thatHml > CdsA-i flies had a higher bacterial load during

septic infection than Hml > UAS-GFP (Hml) control flies and a

load similar to that of Hml > Pex5-i flies (Figure 3C). Notably,

Hml > Pex5-i;CdsA flies had a lower bacterial load than Hml >

Pex5-i flies during infection (Figure 3C). Together, these data

show that expression of CdsA in Pex1 cells reduces PA levels

at the cell membrane and rescues cortical cytoskeleton organi-

zation and survival of Hml > Pex5-i flies after infection.

FOXO responds to peroxisome depletion and
contributes to DGK-mediated synthesis of PA in Pex1

cells
PA is synthesized from DAG by DGK (Figure 2B). We depleted

DGK in S2 cells (DGK-i) and assessed their cortical actin cyto-

skeleton organization upon infection. Uninfected DGK-i cells

showed reduced cortical cytoskeleton organization and mem-

brane protrusion formation to the extent observed in uninfected

Pex1 cells (Figure 3A). In contrast, infected DGK-i cells showed

modest cytoskeleton defects that were not as severe as those

of infected Pex1 cells (Figure 3A). However, depletion of DGK

in Pex1 cells (Pex1;DGK-i cells) rescued the defects in cytoskel-

eton organization and protrusion formation of infected Pex1 cells

(Figure 3A). These data suggest that a metabolic shift toward an

enhanced conversion of DAG to PA and/or an accumulation of

PA in Pex1 cells affects cytoskeleton remodeling (Figure 3A).

DGK expression was upregulated in both Pex5-i and Pex1

cells during infection (Figures 2A and 2B; Figure S1H). In mam-

mals, DGK transcription is mediated by the Forkhead box class

O (FOXO) transcription factors (Akasaki et al., 2014; Battiprolu

et al., 2012; Gross et al., 2008), and FOXO transcription binding
deling and reduce host survival during bacterial infection

ods, E. coli. Bar, 10 mm.

ml > Pex5-i;CdsA flies injected with vehicle or Ecc15.

x5-i; DGK, Hml > FOXO, and Hml > Pex5-i;FOXO flies injected with vehicle or

; red rods, E. coli. Bar, 10 mm.

cated treatment. Values reported are for 400 flies per genotype and condition in

dependent experiments in (B)–(D), and three independent experiments in (G).

), a one-way ANOVA test in (C), and a two-way ANOVA test in (G). ****p < 0.0001;

s. Red asterisks, significance compared with Pex1 cells. See also Figures S1
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sites have been identified in the promoters of DGK genes across

phyla, including the Arthropoda that contains Drosophila (Webb

et al., 2016). FOXO is a regulator of metabolism and innate immu-

nity in Drosophila and mammals (Becker et al., 2010; Fink et al.,

2016; Cabrera-Ortega et al., 2017; Dionne et al., 2006; Molaei

et al., 2019; Seiler et al., 2013). FOXO signaling is enriched in

our transcriptomic analysis (Figure 1D), and FOXO gene expres-

sion is upregulated in Pex5-i cells compared with CTLs during

infection (Table S2). We asked whether metabolic and immune

cues in cells lacking functional peroxisomes might trigger

FOXO-mediated upregulation of DGK expression leading to the

accumulation of PA. Depletion of FOXO in Pex1 cells (Pex1;-

FOXO-i cells) partially rescued the cortical cytoskeleton and

membrane protrusion defects of infected Pex1 cells (Figure 3A).

Moreover, FOXO depletion in Pex1 cells also rescued the upre-

gulation of DGK expression observed during infection of Pex1

cells (Figure S2E). FOXO localized in the cytoplasm of uninfected

CTLs andPex1 cells. FOXOwas at the limit of detection in the nu-

cleus in infected CTLs but was mostly nuclear in infected Pex1

cells (Figures S2F and S2G).

To explore the effects of DGK and FOXO on host response to

infection in vivo, we modulated DGK or FOXO expression in

plasmatocytes during septic infection of flies. Adult flies with

targeted OE of DGK (Hml > DGK) or FOXO (Hml > FOXO) in plas-

matocytes had reduced capacity to fight septic infection than

control Hml > UAS-GFP (Hml) flies (Figure 3D). Similar to

Hml > Pex5-i flies, 40%–50% of Hml > DGK flies and 90% of

Hml > FOXO flies died 4 days after infection, and 100%died after

8 days (Figure 3D). Additionally, OE of DGK (Hml > Pex5-i;

DGK) or FOXO (Hml > Pex5-i;FOXO) in Hml > Pex5-i plasmato-

cytes caused lethality of flies to septic infection at the same

rate as for Hml > Pex5-i flies (Figure 3D). Together, these data

suggest that FOXO responds to signaling driven by a depletion

in peroxisomes during infection and contributes to the upregula-

tion of DGK expression. Increased DGK amounts lead to PA

accumulation in infected cells depleted for peroxisomes, trig-

gering cytoskeleton defects that are detrimental to the host’s ca-

pacity to survive systemic bacterial infections.

Depletion of PS synthetic pathways also contributes to
cytoskeleton defects in Pex1 cells
PA can also be synthesized from PC/PE by phospholipase D

(PLD), which is part of the PS synthetic pathway (Miller et al.,

1993) (Figure 2B). We generated PLD-i S2 cells and assessed

the organization of the cortical actin cytoskeleton upon infection.

Uninfected PLD-i cells exhibited reduced organization in the

cortical cytoskeleton and reduced formation of membrane pro-

trusions to the extent observed in uninfected Pex1 cells (Fig-

ure 3E). We also tested CG4825-i cells that are depleted for PS

synthase (CG4825), the enzyme that produces PS from PC and

DAG. CG4825-i cells exhibited defects in cortical cytoskeleton

organization similar to those observed in Pex1 cells (Figure 3E).

Pex1;CG4825-i cells showed defects in cortical cytoskeleton or-

ganization similar to those observed in Pex1 cells and CG4825-i

cells (Figure 3E). Thus, peroxisome-dependent accumulation of

PA and reduced amounts of its metabolic products, PI and PS,

impact immune cell cytoskeleton remodeling that in turn affects

cellular responses to infection in vitro and in vivo.
Peroxisomal b-oxidation contributes to the cellular lipid
metabolic response to infection
Peroxisomal b-oxidation contributes to GL synthesis (Guo et al.,

2007; Herzog et al., 2016; Lodhi and Semenkovich, 2014). There-

fore, we testedwhether actin cytoskeletal remodeling in response

to infection relies on GL metabolic inputs from peroxisomal

b-oxidation. Thiolase-i cells depleted of the peroxisomal b-oxida-

tion enzyme, thiolase (Faust et al., 2012), did not exhibit mem-

brane protrusions when infected (Figure 3F). Infected Pex1 cells

depleted of thiolase (Pex1;Thiolase-i) showed defects in the

cortical cytoskeleton like those in infected Pex1 cells (Figure 3F).

DHAPAT-i cells depleted of dihydroxyacetonephosphate acyl-

transferase (DHAPAT), an enzyme that catalyzes the first step of

ether lipid synthesis that occurs only in peroxisomes, were unaf-

fected incytoskeleton remodelingormembraneprotrusion forma-

tion during infection (Figure 3F). Moreover, DHAPAT depletion in

uninfected or infected Pex1 cells (Pex1;DHAPAT-i cells) did not

enhance or suppress the defects observed in Pex1 cells (Fig-

ure 3F). Disruptions in peroxisomal b-oxidation lead to increased

levels of free fatty acids (FFAs) (Sellin et al., 2018), which can

induce the formation of DAGs and TAGs (Lam et al., 2003). In-

fected Pex5-i cells accumulated DAG and TAG and exhibited

elevated production of PA from DAG. To determine if defects in

cellular responses to bacteria were due in part to excess FFAs,

we treated S2 cells for 24 h with an FFA cocktail and observed

cortical cytoskeleton defects in treated cells during infection

similar to those observed in CTLs treated with PA (Figure 3F).

Moreover, cytoskeleton defects were partially rescued when

Pex1 cells were treated prior to infection with niacin, an analog

of vitamin B3, which has been shown to reduce the amounts of

FFAs in mammals and flies (Di Cara et al., 2018; Nelson et al.,

2012) (Figure 3F). Interestingly, the upregulation of DGK expres-

sion in infected Pex1 cells pretreated with niacin was rescued to

the level observed in infected CTLs (Figure S2E). Quantification

of the area of cells of each genotype and under each condition

(Figure 3G) confirmed the microscopic observations.

In agreement with these data, flies globally disrupted for

peroxisome function (ubi > Pex5-i) had higher levels of FFAs rela-

tive to controls (Figure S2H). Feeding CTL flies and ubi > Pex5-i

flies niacin for 15 days reduced the FFA levels of ubi > Pex5-i flies

to the FFA levels of control flies (Figure S2H). We next tested the

survival of ubi > Pex5-i flies treated with niacin to infection with

Ecc15. While ubi > Pex5-i flies died 3 days after infection, those

given an oral treatment of niacin for 15 days prior to infection

showed a 30% increase in survival on day 3 post-infection rela-

tive to untreated ubi > Pex5-i flies (Figure S2I). Thus, peroxisomal

b-oxidation contributes to the lipid cellular changes necessary

for the remodeling of the cytoskeleton during the activation of im-

mune cells during infection and impacts the ability of the host to

survive systemic infection in vivo.

Defects in peroxisomal metabolism but not
mitochondrial metabolism result in cytoskeleton
defects in S2 cells
Mitochondria and peroxisomes collaborate to maintain cellular

lipid homeostasis. Damage to one organelle may affect the

metabolic activities of the other. Thus, we tested mitochondrial

metabolism in CTLs and Pex1 cells before and after bacterial
Cell Reports 38, 110433, March 1, 2022 9
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infection. Respiration rates were significantly higher in Pex1 cells

than CTLs (all p < 0.001; Figure S3A). However, when respiration

rates were normalized to complex IV maximal capacity, which is

considered a good marker for mitochondrial content, no signifi-

cant differences were detected between Pex1 cells and CTLs

(Table S3). These results suggest that both CTLs and Pex1 cells

exhibit similar mitochondrial efficiency and that the differences

observed between them are likely due to a difference in mito-

chondrial content. Therefore, we perturbed the mitochondrial

respiratory chain and mitochondrial Krebs cycle by depleting

the geneND75 encoding the NADH dehydrogenase 75 kDa sub-

unit and the gene CG3861 encoding citrate synthase in Pex1

cells. Cortical cytoskeleton defects and reduced numbers of

membrane protrusions were not rescued in either ND75-i cells

or citrate synthase-i cells when infected with E. coli (Figure S3B),

suggesting that the cytoskeleton defects observed in Pex1 cells

during infection are not caused by increased mitochondrial

metabolic activity. Additionally, when we perturbed the mito-

chondrial respiratory chain or the mitochondrial Krebs cycle in

CTLs, we did not observe defects in the cortical cytoskeleton

during infection (Figures S3C and S3D). These data suggest

that the cortical cytoskeleton defects observed in Pex1 cells

are the result of altered peroxisomal metabolism.

Elevated amounts of PA in the cell membrane alter the
localization of Rho GTPase and prevent its activation in
S2 cells
The Rho family of small GTPases plays a pivotal role in trans-

lating extracellular cues, including the signaling arising from mi-

crobial detection, into relevant cell responses (Burkhardt, 2013;

Yeung et al., 2008). Rac1 and Rho1 (RhoA in mammals) function

together to regulate actin cytoskeleton remodeling required for

immune cell migration, granule release, formation of immunolog-

ical synapses, and phagocytosis (Aflaki et al., 2011; Bros et al.,

2019; Flannagan et al., 2012; Vicente-Manzanares and San-

chez-Madrid, 2004; Williams, 2007; Zettervall et al., 2004).

Distinct GLs at the cell membrane recruit and activate Rho and

other signaling proteins. Given that peroxisomes contribute to

the GL milieu and defects in the cytoskeleton are evident in

Pex5-i cells during infection, we asked if peroxisome function

was required for the membrane localization of GTPases during

microbial challenge.

Rac1 was largely cytoplasmic while Rho1 localized at sites of

membrane protrusion in infected CTLs, but both Rac1 and Rho1

appeared as cytoplasmic puncta in Pex1 cells (Figures 4A–4D).

To test if this change in GTPase location in Pex1 cells also

affected the activity of Rac1 and Rho1, we measured the activity

of Rac1 andRho1 in resting and infectedCTLs andPex1 cells us-

ing an ELISA-based assay. Our measurements revealed that

both Rac1 and Rho1 are activated in CTLs 30 min after infection

but failed to be activated in infected Pex1 cells (Figures 4E and

4F).

Infected CTLs showed a substantially remodeled cortical actin

cytoskeleton, while infected Pex1 cells showed cortical cyto-

skeleton and cell protrusion defects (Figures 4G and 4H). We ex-

pressed constitutively active forms of either Rac1 (Rac1V12) or

Rho1 (Rho1V14) in CTLs and Pex1 cells and stained the actin

cytoskeleton (Luo et al., 1994). In CTLs, Rac1V12 induced actin
10 Cell Reports 38, 110433, March 1, 2022
cytoskeleton remodeling and the formation of membrane protru-

sions in both the presence and absence ofE. coli (Figures 4G and

4H). Rac1V12 expression could not rescue the actin cytoskeletal

defects of uninfected and infected Pex1 cells (Figures 4G and

4H), whileRho1V14 rescued the defects in actin cytoskeleton or-

ganization and formation of membrane protrusions in Pex1 cells

(Figures 4G and 4H). The cytoskeleton remodeling that occurs in

response tomicrobial stimuli was dependent onRho1 activity, as

CTLs expressing a dominant negative form of Rho1, Rho1N19,

failed to form membrane protrusions when infected (Figures

4G and 4H).

Macrophage activation in response to bacterial infection stim-

ulates the cytoskeletal reorganization required for phagosome

formation (Mao and Finnemann, 2015). Pex1 cells or CTLs ex-

pressing Rho1N19 showed reduced uptake of fluorescently

labeled E. coli compared with CTLs (Figure S4B). This reduction

in bacterial uptake by Pex1 cells was rescued by expression of

Rho1V14 (Figures S4A–S4E).

Plasmatocytes from control adult flies (Hml > GFP) showed

substantial cortical cytoskeleton staining in response to E. coli

compared with the round plasmatocytes from Hml > Pex5-i flies

or Hml > Rho1N19 flies (Figure 5A). Expression of Rho1V14 in

Hml > Pex5-i plasmatocytes (Hml > Rho1V14;Pex5-i) rescued

cortical cytoskeleton staining in infected cells (Figure 5A). More-

over, likeHml>Pex5-i plasmatocytes, infectedHml>CdsA-i plas-

matocytes remained round and did not develop membrane pro-

trusions (Figure 5A). Expression of Rho1V14 in Hml > CdsA-i

plasmatocytes (Rho1V14;Hml>CdsA-i) rescuedcytoskeleton re-

modeling upon infection (Figure 5A), supporting the concept that

metabolic defects caused by PA accumulation in peroxisome-

depleted immune cells affect Rho1 signaling needed to trigger

cortical cytoskeleton remodeling upon infection.Additionally, flies

overexpressing FOXO in plasmatocytes (Hml > FOXO) showed

the same cytoskeletal defects as Hml > Pex5-i and Hml > CdsA-

i plasmatocytes, but the defects in Hml > FOXO plasmatocytes

could be rescued by expression of Rho1V14 (Figure 5A). Ratio-

metric analysis of cytoplasmicGFPandcortical phalloidin fluores-

cence indicated that expression of Rho1V14 in Hml > Pex5-i,

Hml > CdsA-i, and Hml > FOXO plasmatocytes rescued their

cortical cytoskeleton defects (Figure 5B).

A downstream effector of Rho1 in Drosophila and mammals is

Rho kinase, which is termed Rok1 or Rock1. Rock1 promotes

the recruitment of actin nucleating factors and remodelers

such as Diaphanous and myosin II (Khoo et al., 2013) and is

involved in regulating immune cell responses to pathogens

(Ricker et al., 2016). OE of Rock1 in Pex1 cells triggered actin

remodeling during infection to yield a cytoskeletal pattern similar

to that seen in CTLs (Figures S4F and S4G), confirming that per-

oxisomes regulate Rho1 signaling to activate cytoskeleton

remodeling.

Rho1 signaling in peroxisome-depleted S2 cells is
inhibited by p190RhoGAP
PA modulates the activity of Rho GTPases via their regulators,

Rho guanine nucleotide exchange factors (RhoGEFs), and Rho

GTPase-activating proteins (RhoGAPs) (Ali et al., 2013; Ishihara

et al., 2020; Kurooka et al., 2011). RhoGAPs function as effectors

or activators of Rho GTPases in response to external stress
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Figure 4. Peroxisomes regulate Rho1-mediated cytoskeleton remodeling in response to bacterial infection

(A) IF microscopy of Rac1. Bar, 10 mm.

(B) Histogram reporting the percentage of cells with Rac1 at membrane protrusions or in the cytoplasm. Values reported are for 30 cells of each genotype.

(C) IF microscopy of Rho1. Bar, 10 mm.

(D) Histogram reporting the percentage of cells with Rho1 at membrane protrusions or in the cytoplasm. Values reported are for 30 cells of each genotype.

(E) Rac1-GTP levels at themembrane or in the cytoplasm in uninfected cells or cells infected with Ecc15. 33 106 cells of each genotype and under each condition

were measured. A.U., arbitrary units.

(F) Rho1-GTPase amounts at the membrane or in the cytoplasm in uninfected cells or cells infected with Ecc15. A.U., arbitrary units.

(G) Actin staining in cells of the indicated genotypes. Red rods, E. coli; red, actin; blue, DNA. Bar, 10 mm.

(H) Histogram reporting the areas of cells of the indicated genotypes and under the indicated conditions. Values for 30 cells. Values in (B)–(H) are the means ± SD

of three independent experiments. Significance was determined by a one-way ANOVA test or by a two-way ANOVA test in (H). ****p < 0.0001; **p < 0.01; *p < 0.05;

ns, not significant. Gray asterisks, significance compared with CTLs. Red asterisks, significance compared with Pex1 cells. See also Figures S2 and S3.
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(Bernards and Settleman, 2004). The expression of five genes

coding for RhoGAPs was highly upregulated during bacterial

infection of Pex5-i cells but not CTLs. We performed a mini-

RNA interference-based screen to select for RhoGAPs required

for cortical cytoskeleton organization and membrane protru-

sions in S2 cells during infection (Figures S5A and S5B). S2 cells

depleted for RhoGAP5A, RhoGAP92B, or RhoGAPp190, but not

for RhoGAP16F or RhoGAP54D, showed alterations in their

cortical cytoskeleton when infected compared with when unin-

fected. Genetic interaction analysis between Pex1 and each of

these RhoGAP genes showed that depletion of RhoGAPp190

rescued the cortical cytoskeleton defects in infected Pex1 cells

(Figures 5C and 5D). In contrast, OE of RhoGAPp190 in infected
CTLs showed cytoskeleton remodeling defects (Figures 5C and

5D). Moreover, RhoGAPp190 is expressed at higher level in in-

fected Pex1 cells than in infected CTLs (Figure S5C). CTLs and

Pex1 cells expressing PABD-RFP and a RhoGAPp190-GFP

showed colocalization of RhoGAPp190-GFP with PABD-RFP

at the membrane in Pex1 cells (Figures 5E and 5F). However,

neither PABD-RFP nor RhoGAP190-GFP was at the plasma

membrane in Pex1 cells when DGK, the enzyme that synthesizes

PA fromDAG, was depleted (Figures 5E and 5F). Together, these

data suggest that in infected Pex1 cells, RhoGAPp190 is re-

cruited by, or acts in concert with, PA at the cell membrane to

inhibit Rho1 signaling and cytoskeleton remodeling, thereby

affecting cellular immune responses.
Cell Reports 38, 110433, March 1, 2022 11
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Peroxisome-dependent defects in Rho1 signaling
decrease host survival of systemic infection
To determine a role for the plasmatocyte peroxisome-GTPase

axis in host defense, we assessed the survival of control Hml >

UAS-GFP (Hml) flies withWT plasmatocytes orHml > Pex5-i flies

with peroxisome-depleted plasmatocytes expressing different

Rho variants after needlestick infection with the entomopatho-

genic bacterium Pseudomonas entomophila (P.e.) (Ragheb

et al., 2017). We used P.e. because it is more pathogenic to

Drosophila than Ecc15, which facilitates the analysis of a require-

ment for peroxisome-GTPase signaling in host defense under a

greater infectious challenge. Uninfected Hml > Pex5-i, Hml >

Rho1N19, Hml > Rho1V14, and Hml > Pex5-i;Rho1V14 flies

were equally viable as uninfected control Hml flies (Figure S5D).

Four days after P.e. infection, Hml > Pex5-i flies showed 40%

survival, and Hml > Rho1N19 flies showed 60% survival (Fig-

ure S5D). Infected Hml > Pex5-i and Hml > Rho1N19 flies died

at a faster rate than Hml control flies (Figure S5D). Rho1V14

expression inHml > Pex5-i flies (Hml > Pex5-i;Rho1V14) rescued

survival to levels observed in control Hml flies and similar to sur-

vival levels observed for Hml > Rho1V14 flies, with 40% of flies

surviving 8 days post-infection.

Hml > Pex5-i flies and Hml > Rho1N19 flies showed higher

pathogen load than Hml > Rho1V14 flies and Hml > Pex5-

i;Rho1V14 flies infected with P.e (Figure S5E). Thus, depletion

of Pex5 or expression of Rho1N19 in plasmatocytes made flies

more susceptible to infection.

Peroxisomes promote Rho1-mediated cytokine
secretion by plasmatocytes in Drosophila

Septic injury in Drosophila induces the secretion of the cytokine

Unpaired3 (Upd3), which is orthologous to mammalian inter-

leukin-6 (Agaisse et al., 2003), by plasmatocytes (Agaisse and

Perrimon, 2004; Pean et al., 2017; Yang et al., 2015). Cytokine

secretion relies on RhoGTPases during vesicle trafficking, a pro-

cess that is broadly conserved among cytokine-producing cells

(Fessler et al., 2007). To determine the effects of peroxisome-

mediated Rho signaling and cytoskeleton remodeling on cyto-

kine secretion, we tested the ability of plasmatocytes from Hml

> Pex5-i flies to secrete Upd3 in response to infection. Upd3

secretion was followed using an Upd3-GFP reporter. Upd3-

GFP was not observed in the body cavity of uninfected control

Hml > Upd3-GFP flies or uninfected Hml > Pex5-i;Upd3-GFP

flies (Figure 6A, panels at left). 73% of control Hml > Upd3-

GFP flies infected with Ecc15 showed GFP in the body cavity

within 6 h of infection, while no infected Hml > Pex5-i;Upd3-
Figure 5. Peroxisomal metabolism mediates signaling by RhoGAPp19

(A) Detection of actin and membrane protrusions in plasmatocytes of the indicate

(B) Histogram reporting the ratios of phalloidin fluorescence intensity to GFP fluo

indicated conditions. Gray asterisks, significance comparedwith controlHml >GF

i plasmatocytes.

(C) Detection of actin and membrane protrusions in cells of the indicated genoty

(D) Histogram reporting areas of cells of the indicated genotypes and under the

asterisks, significance compared with Pex1 cells.

(E) Imaging of the PA reporter, PABD-RFP, and of RhoGAPp190-GFP. Bar, 10 m

(F) Histogram reporting the percentage of cells with RhoGAPp190-GFP or PABD-R

are themeans ±SD of three independent experiments totaling 30 cells. Significanc

(D), and Student’s t test. ****p < 0.0001. See also Figures S4 and S5.
GFP flies showed GFP in the body cavity (Figure 6A, panels at

right). However, GFP was observed in the body cavity in 64%

of infected flies when Rho1V14 was expressed in Hml > Pex5-i

flies (Hml > Pex5-i;Rho1V14). Intriguingly, Hml > CdsA-i flies,

which are depleted for the enzyme that converts PA to CDP-

DAG and thus accumulate PA (Figure 2B), did not show Upd3-

GFP in the body cavity when infected (Figure 6A, panels at right).

Our data show that peroxisomes regulate the secretion of the im-

mune-responsive cytokine Upd3 in response to bacterial infec-

tion by contributing to the cellular glycerophospholipid milieu

required to activate Rho1-mediated cytoskeleton remodeling

and to initiate the immune response.

Peroxisomal metabolism regulates Rho1-mediated
cytokine secretion by murine macrophages
We analyzed bone marrow-derived macrophages (BMDMs)

from homozygous Peroxin2 (Pex2�/�) mutant mice to assess

whether peroxisomal metabolic control of GL amounts promotes

cytoskeleton remodeling and activation of mammalian macro-

phages as measured by cytokine release. The Pex2 gene en-

codes a ubiquitin ligase (Biermanns et al., 2003) needed to

recycle the Pex5 receptor (Smith and Aitchison, 2013). Pex2�/�

mice carry a recessive mutation in both copies of the Pex2

gene (Figures S6A and S6B) and show peroxisome biogenesis

defects similar to those observed in Pex5 mutant mice, such

as a loss of targeting of catalase to peroxisomes (Figure S6C).

Because Pex5�/� mice die at birth, we chose to use Pex2�/�

mice for our studies, as they can survive up to 20 days.

We previously reported a requirement of peroxisomes for

phagocytosis (Di Cara et al., 2017). We therefore tested the abil-

ity of Pex2�/� BMDMs to engulf fluorescently labeled bacteria.

Pex2�/�BMDMs engulfed 30%–40% less bacteria than BMDMs

from littermate control mice (Figure S6D). Compromised phago-

cytosis in Pex2�/� BMDMs was not associated with defects in

macrophage development, as Pex2�/� macrophage maturation

was intact (Figures S6E and S6F). These results suggest that

Pex2 is required for peroxisomes to drive phagocytosis.

We assayed the cytokine response in Pex2�/� BMDMs to test

if Pex2 is required for cytokine release in response to immune

elicitors, as has been observed for Pex5 in Drosophila. Using a

cytokine array, we screened for a variety of cytokines and che-

mokines released by Pex2�/� BMDMs after stimulation with

LPS. Pex2�/� BMDMs secreted few cytokines and chemokines

in response to LPS stimulation compared with WT BMDMs (Fig-

ures 6B and 6C). We confirmed that LPS-treated Pex2�/�

BMDMs did not secrete detectable IL-6 and TNF-a, and they
0-Rho1

d genotypes. Green, cytoplasmic GFP; red rods, E. coli; red, actin. Bar, 10 mm.

rescence intensity in plasmatocytes of the indicated genotypes and under the

P plasmatocytes. Red asterisks, significance comparedwithHml >GFP;Pex5-

pes. Green, actin; red rods, E. coli; blue, DNA. Bar, 10 mm.

indicated conditions. Gray asterisks, significance compared with CTLs. Red

m.

FP at themembrane in cells of the indicated genotype. Values in (B), (D), and (F)

e was determined using a one-way ANOVA test in (B), a two-way ANOVA test in
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Figure 6. Peroxisome metabolism regulates Rho1-mediated cytokine release in response to microbial challenge in Drosophila and mouse

(A) Thoracic injection of bacteria into adult flies triggers secretion of the cytokine Upd3 by plasmatocytes.

(B) Mouse cytokine array analysis of cytokines and chemokines secreted by WT and Pex2�/� BMDMs in the absence or presence of LPS.

(C) Histogram reporting themean pixel density for each spot detected in themouse cytokine array for BMDMs of the two genotypes and under the two conditions.

(D–F) IL-6 (D), TNF-a (E), and IL-1b (F) secretion by WT, Pex2+/�, and Pex2�/� BMDMs in the absence or presence of LPS.

(G) Histogram reporting the amount of PA in membrane and cytoplasmic fractions isolated from WT and Pex2�/� BMDMs that were unstimulated or stimulated

with LPS.

(H) Histogram reporting the amount of IL-6 secreted by WT and Pex2�/� BMDMs under the indicated treatments.

(legend continued on next page)
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secreted very low levels of IL-1b compared with the levels

secreted by WT or Pex2 heterozygous (Pex2+/�) BMDMs (Fig-

ures 6D–6F). However, measurement of transcripts for IL-6,

TNF-a, and IL-1b by qRT-PCR revealed that Pex2�/� BMDMs

had the same transcript levels for these cytokines as did WT

and Pex2+/� BMDMs (Figure S6G). Because of this observation,

we assessed IL-6 and TNF-a protein synthesis in Pex2�/�

BMDMs and saw granules containing IL-6 and TNF-a in LPS-

treated Pex2�/� BMDMs (Figures S6H and S6I). Together, these

data show that Pex2 is needed for cytokine release by macro-

phages but not for cytokine gene transcription or mRNA

translation.

Given the lipid metabolic defects we observed in Drosophila

Pex5-i and Pex1macrophages and their effects on cytoskeleton

remodeling and Upd3 cytokine release, we tested whether

similar lipid metabolic defects were linked to cytokine secretion

by Pex2�/� BMDMs. We measured PA in LPS-treated WT and

Pex2�/� BMDMs and found greater amounts of PA in the mem-

brane fraction and lesser amounts in the cytoplasm fraction of

Pex2�/� BMDMs compared with WT BMDMs (Figure 6G). Like

Pex1 fly macrophages, LPS-treated Pex2�/� BMDMs had lower

amounts of PIP3 in their membranes (Figure S6J). Moreover,

PIP2 was detected in LPS-treated WT BMDMs but not in LPS-

treated Pex2�/� BMDMs (Figure S6K). Thus, Pex2�/� murine

macrophages exhibit similar alterations in their GL profiles to

those observed in Drosophila S2 cells.

We next tested whether the altered cellular lipid environment

observed in peroxisome-depleted Pex2�/� BMDMs was linked

to changes in cytokine secretion by these cells. When WT

BMDMs were treated with an FFA cocktail or PA, LPS-induced

IL-6 secretion was inhibited (Figure 6H). Moreover, Pex2�/�

BMDMs treated with niacin, an FFA scavenger, were able to

secrete IL-6 upon LPS stimulation (Figure 6H).

To evaluate whether mutation of Pex2, together with the asso-

ciated GL metabolic defects in murine macrophages, affected

Rho-dependent cytoskeleton remodeling and cytokine secretion

as seen in Drosophila, we measured the activity of RhoA, the or-

thologue of Drosophila Rho1, in LPS-treated WT and Pex2�/�

BMDMs. RhoA activity increased in WT BMDMs 20 min after

LPS addition, while it remained unchanged in Pex2�/� BMDMs

and WT BMDMs treated with the RhoA inhibitor, Rhosin (Fig-

ure 6I). However, Pex2�/�BMDMs treated with a RhoA activator,

CN04, showed greatly increased RhoA activity. WT BMDMs

treated with Rhosin or the broad spectrum GTPase inhibitor,

EHop016, did not secrete IL-6 upon LPS treatment (Figure 6J),

suggesting that RhoA signaling is needed for IL-6 secretion by

mouse macrophages.

We next assessed if defects in the cellular lipid milieu, RhoA

signaling, and cytokine secretion were due to disruption of the

macrophage cortical actin organization. Infected Pex2�/�

BMDMs lacked membrane protrusions and exhibited a less

organized cortical cytoskeleton, as measured by a smaller

mean cell area, than that of infected WT BMDMs (Figures 7A
(I) Histogram reporting RhoA GTPase activity in WT and Pex2�/� BMDMs under

(J) Histogram reporting the amount of IL-6 secreted by WT and Pex2�/� BMDM

dependent experiments in (A) and (E)–(J), and of six independent experiments in

test. ****p < 0.0001; ***p < 0.001; ns, not significant. See also Figure S6.
and 7B). The cortical cytoskeleton of WT BMDMs treated with

PA or with a cocktail of FFAs was less organized than that of un-

treated WT BMDMs (Figures 7A and 7B). In contrast, Pex2�/�

BMDMs treatedwith niacin showed a cortical cytoskeleton orga-

nization like that of WT BMDMs (Figures 7A and 7B), confirming

that the lipid defects present in Pex2�/�BMDMs inhibit cytoskel-

eton remodeling. In addition, WT BMDMs treated with Rhosin

showed cortical cytoskeleton defects (Figures 7A and 7B). Of

note, treatment of Pex2�/� BMDMs with a RhoA activator

rescued the cytoskeleton defects seen in untreated cells (Figures

7A and 7B). Together these data suggest that mutation in the

peroxisome biogenesis factor Pex2 causes changes in the GL

milieu that are linked to Rho-GTPase-mediated cortical actin re-

modeling and cytokine release in challenged BMDMs.

Since LPS is a Toll-like receptor (TLR) 4 agonist, we next inves-

tigated whether peroxisomal metabolism affects only TLR4-

dependent cytokine responses or also cytokine responses

dependent on other TLRs. We stimulated WT and Pex2�/�

BMDMs with Pam3CSK4, a TLR1 and TLR2 agonist, and with

R848, a TLR7 and TLR8 agonist (Geng et al., 2015). Pex2�/�

BMDMs did not secrete IL-6 in response to treatment with

Pam3CSK4 but did secrete IL-6 in response to treatment with

R848 (Figures S6L and S6M). Because TLR1, TLR2, and TLR4

are located at the cell membrane, and TLR7 and TLR8 are intra-

cellular, the different responses of Pex2�/� BMDMs to

Pam3CSK4 and R848 suggest that Pex2�/� mutation may affect

signaling arising at the cell surface but not intracellularly.

Together, our data support a scenario in which peroxisomes

direct cellular lipid metabolism, contribute to GL production

and localization, and promote cytoskeleton rearrangement, all

of which combine to allow the cell to translate signals from

outside the cell to inside the cell to control immune defense

mechanisms such as proinflammatory cytokine release.

Peroxisomal lipid metabolism is needed for
proinflammatory responses from human peripheral
blood mononuclear cells
Rho GTPases and their downstream effector kinases control im-

mune cell mobilization and secretion of proinflammatory cyto-

kines in response to stimuli. Dysregulation of these signaling

cascades contributes to proinflammatory immune disorders

characterized by aberrant cytokine production and unresolved

inflammation resulting from unwarranted immune responses

(Biro et al., 2014). Given the conserved role that peroxisomes

play in the regulation of cytoskeleton-mediated immune pro-

cesses, including activation of proinflammatory responses in

macrophages, we investigated whether peroxisomes are asso-

ciated with chronic inflammatory phenotypes. We examined pe-

ripheral blood mononuclear cells (PBMCs) of patients affected

by the severe inflammatory disorder Kawasaki disease (KD).

PBMCs from KD patients had more anti-SKL-positive staining

of peroxisomes than PBMCs from healthy donors (Figures 7C

and 7D). PBMCs from KD patients had reduced amounts of PA
the reported treatments.

s under the reported treatments. Values reported are means ± SD of three in-

(D). Statistical significance in (A) and (D)–(J) was determined using Student’s t
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Figure 7. Peroxisomal metabolism contributes to inflammatory responses

(A) Actin staining in WT and Pex2�/� BMDMs under the indicated conditions. Red, actin; red rods, E. coli; blue, DNA. Bar, 10 mm.

(B) Histogram reporting the areas of BMDMs of the indicated genotypes and under the indicated conditions. Gray asterisks, significance compared with WT

BMDMs; red asterisks, significance compared with Pex2�/� BMDMs.

(C) IF microscopy of anti-SKL antibody (a-SKL) staining in PBMCs from healthy individuals (CTL) or KD patients. Red, a-SKL; blue, DNA. Bar, 10 mm.

(D) Histogram reporting the number of a-SKL-positive puncta per region of interest (ROI) in CTL or KD PBMCs.

(E) Histogram reporting PA amounts in the cell membrane fraction from LPS-treated CTL and KD PBMCs.

(F) IF microscopy of a-SKL staining of SFFs from healthy individuals (CTL) and JIA patients. Red, a-SKL; blue, DNA. Bar, 10 mm.

(G) Histogram reporting the number of a-SKL-positive puncta per ROI in CTL or JIA SFFs. Values are means ± SD of four independent experiments totaling 20

cells in B, of two independent experiments totaling 30 ROIs in (D) and (G), and of three independent experiments in (E). Significance in (B), (D), (E), and (G) was

determined using Student’s t test. ****p < 0.0001; ***p < 0.001; **p < 0.01. See also Figures S6 and S7.
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compared with control PBMCs (Figure 7E), suggesting that

immune cells with increased numbers of peroxisomes have

reduced amounts of PA and exhibit a severe inflammatory

phenotype.

We next treated healthy donor PBMCs with LPS or a cocktail

of proinflammatory cytokines (IL-6, IL-1b, TNF-a) to reproduce

the inflammatory properties of KD PBMCs. FC analysis showed

that healthy donor PBMCs treated for 24 h with LPS exhibited

more anti-SKL-positive staining than untreated healthy donor

PBMCs (Figures S7A and S7D). The increase in anti-SKL-posi-
16 Cell Reports 38, 110433, March 1, 2022
tive staining was observed specifically in B cells (CD19+) and

monocytes (CD14+) (Figures S7A and S7D) but not in NK cells

(CD56+) or T cells (CD8+, CD4+) (Figures S7B, S7C, and S7E).

Similar results were obtained with the cytokine cocktail

(Figure S7).

We next analyzed synovial fluid fibroblasts (SFFs) from juvenile

idiopathic arthritis (JIA) patients for further evidence that perox-

isomes support a cellular inflammatory phenotype. SFFs from

JIA patients exhibit a strong inflammatory phenotype and are

considered the primary source of the proinflammatory cytokine
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storm that drives joint inflammation in JIA patients. Fibroblasts

from JIA patients exhibited increased numbers of anti-SKL pos-

itive puncta than SFFs from healthy individuals (Figures 7F and

7G). Thus, cells exhibiting an inflammatory phenotype had

more peroxisomes and reduced amounts of PA in their cell mem-

brane than cells not exhibiting an inflammatory phenotype.

These data in human cells are in our agreement with our results

from Drosophila and mouse macrophages showing low inflam-

mation and high amounts of PA in cells lacking functional

peroxisomes.

DISCUSSION

Evidence showing that metabolic programs govern specific im-

mune cell functions has grown (Hooftman et al., 2020; O’Neill

et al., 2016; O’Neill and Pearce, 2016; Ryan and O’Neill, 2020).

Dysregulation of lipidmetabolismhas been implicated in the aber-

rant function of macrophages in diseases such as atherosclerosis

and obesity and in certain intracellular infections (Yan and Horng,

2020). Here, we explored the contribution of the peroxisome, a

key metabolic organelle, to the lipid-mediated signaling that

guides the macrophage response to acute infection. Using

Drosophila, a well-known model system for studying immune

and metabolic signaling (Galenza and Foley, 2019; Lemaitre and

Hoffmann, 2007), we found that peroxisomal metabolism contrib-

utes to the GL milieu required to mediate processes of macro-

phage immune activation, such as cytokine release.

Actin remodeling enables the reorganization of the plasma

membrane needed for proper receptor localization, recruitment

of signaling intermediates, and changes in cell morphology

required for macrophage immune activation. Thus, actin remod-

eling regulates many of the cellular programs that drive macro-

phage differentiation, activation, proliferation, and survival. We

have shown that peroxisomes are pivotal to triggering actin re-

modeling cascades in macrophages during the early stages of

infection. The importance of regulating the actin cytoskeleton

for leukocyte function is emphasized by conditions such as neu-

tropenia and by animal models of immunodeficiency in which

genes involved in regulating actin have been targeted. It is now

clear that mutations in cytoskeletal proteins can lead to immuno-

deficiency or autoimmunity, and that pathogens subvert immune

cells by manipulating cytoskeletal dynamics (Salzer et al., 2020).

Rho GTPases are known regulators of actin dynamics and rear-

rangement (Mao and Finnemann, 2015). Rho GTPases contribute

to immune cell function, and serious immune dysfunctionalities

have been shown to be due to defects in individual GTPases (Ar-

bibe et al., 2000; Bokoch, 2005) and their regulators (Biro et al.,

2014). A specific composition ofGLswithin the plasmamembrane

is required to activate key cytoskeletal remodeling factors such as

Rho1 in Drosophila cells and RhoA in mammalian cells (Aflaki

et al., 2011; Bros et al., 2019; Flannagan et al., 2012; Sit andMan-

ser, 2011; Williams, 2007; Zettervall et al., 2004). Our findings in

both fly and mouse show that peroxisomal b-oxidation contrib-

utes to changes in plasmamembraneGLcomposition that control

cytoskeleton remodeling that in turn contributes to the macro-

phage’s capacity tomount an immune response tomicrobial chal-

lenge by modulation of the Rho1/RhoA cascade. Specifically, we

observed that a high concentration of PA accumulates in the
plasma membrane of Pex1 cells. The amounts of PA in the cell

change dynamically in response to external stimuli, and PA is

important for mediating diverse cellular and physiological pro-

cesses in eukaryotes. For example, PA plays a central role in

the recruitment of proteins to the plasma membrane to promote

signal transduction, and PA can modulate the activity of the Rho

family of GTPases and their regulators, RhoGEFs and RhoGAPs

(Ali et al., 2013; Ishihara et al., 2020; Kurooka et al., 2011).

Some studies have concluded that RhoGAPs function as negative

regulators of Rho GTPases (Bernards and Settleman, 2004), such

that inhibition of RhoGAP activity is sufficient to promote Rho acti-

vation and downstream responses. We showed that Rho-

GAPp190 is regulated by PA, a peroxisome metabolite, which in-

hibits Rho1 and immune cell activation. Of note, the two

RhoGAPp190s in the mammalian genome, p190-A and p190-B,

are tightly regulated transcriptionally and post-transcriptionally

in response to external changes such as increased insulin levels

or exposure to alcohol (Bernards and Settleman, 2004; Heraud

et al., 2019), supporting their important role in responding to

stressors. Our study adds to our understanding of the complex

mechanisms that regulate Rho GTPase signaling and identify a

specific role for RhoGAPp190 as a negative regulator of the

macrophage response to microbial stimuli.

Our findings have implications for a variety of immune and in-

flammatory conditions with underlying lipid metabolic defects,

such as atherosclerosis, autoimmune disease, and conditions

like osteoarthritis that exhibit local or systemic changes in PA

(Singh and Aballay, 2017). Our observations that peroxisome

numbers increase in response to inflammatory stimuli in both

mouse and human cells and that peroxisome numbers were

elevated in the PBMCs of KD patients and SFFs of JIA patients

suggest that peroxisome-mediated lipid changes impact the in-

flammatory status of immune cells. Our study paves the way for

further studies aimed at defining the immunomodulatory roles of

peroxisomes and how lipids that control inflammatory signaling

in immune disorders are regulated, potentially opening up thera-

peutic avenues for treating these disorders. Overall, our findings

reveal the peroxisome to be a major modulator of multiple

cellular immune functions across diverse phyla.

Limitation of the study
Glycerophospholipids are key signaling molecules in many cell

signaling pathways, including those involved in immunity. Glyc-

erophospholipids can be produced by various pathways located

in different subcellular compartments. Here, we define the

peroxisome, a ubiquitous membrane-enclosed organelle, as an

important contributor to glycerophospholipid signaling that reg-

ulates immune defense processes in macrophages.

There are limitations to our study. We were unable to define if

the signaling lipids, PA and phosphatidylinositol phosphates

(PIPs), are made by the peroxisome and if their amounts in the

cell are indirectly affected by dysfunction in peroxisomal

b-oxidation. Also, the size of S2 cells hampered us in deter-

mining whether peroxisomes recruit the enzymes required to

produce PA and PIPs. Given that our current study shows this

signaling pathway is conserved in mammalian cells, we are

confident that murine or human macrophages would be suitable

for these future studies.
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Finally, we identified PA as ametabolic marker of inflammation

in cells of patients affected by autoimmune disease. However,

we could not define amechanism linking peroxisomes, PA accu-

mulation, and inflammatory signaling. Finding this link is an

ongoing pursuit for our team.
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Antibodies

Mouse peroxisomal Catalase abcam ab16771

Rabbit polyclonal anti SKL Rachubinski U of A Szilard et al., 1995

Mouse anti Rho1 the Developmental Studies Hybridoma

Bank

p1D9

Mouse anti- CD11b BioLegend M1/70

Mouse anti- F4/80 BioLegend BM8

Rat antibody hemagglutinin protein (HA) Sigma-Aldrich 3F10

Mouse anti-PIP2 Enzo ADI-915-062-100

Mouse antibody Flag M2 Sigma-Aldrich F3165

Rabbit anti-FOXO antibody Abcam ab1959770

Mouse a-Tubulin Sigma-Aldrich T5168

Rabbit antibody Pex2 Proteintech 22163-i-AP

Mouse antibody CD3 Clone OKT3 BioLegend 317352

Mouse antibody CD4 Clone OKT4 BioLegend 317438

Mouse antibody CD19 Clone HIB19 BD 302240

Mouse antibody CD14 Clone M4P9 BD 566466

Mouse antibody CD8 Clone SK1 BD 563919

Mouse antibody CD56 Clone NCAM16.2 BD 565139

Mouse antibody IL-6 MP5-20F3 BD MP5-20F3

Mouse antibody TNF-a BD MP6-XT22

Mouse antibody CD8a AF 647 Ebiosciences 53-6.7

Mouse antibody H2Kb BioLegend AF6-88.5

Mouse antibody CD11c BioLegend N418

Mouse antibody I-A/I-E antibody I-A/I-E N/A

Bacterial and virus strains

mCherry-expressing E. coli Pukatzki Stefan, U of A MacIntyre et al., 2010

Ecc-15 (2141) Dr. Edan Foley, U of A Basset et al., 2000

P. entomophila Dr. Nicolas Buchon, Cornell University. Ragheb et al., 2017

Biological samples

PBMC This study N/A

Synovial Fibroblast This study N/A

Chemicals, peptides, and recombinant proteins

Lypopolysaccharides O55:B5 Sigma-Aldrich L6529

Free Fatty Acids supplement Sigma-Aldrich F7050

phosphatidic acid sodium salt Sigma-Aldrich P9511

Nicotinic Acid Sigma-Aldrich 481918

Pam3CSK4 InvivoGen tlrl-pms

R848 InvivoGen inh-cc9a

ATP Sigma-Aldrich A1852

Rhosin (Merck), Sigma-Aldrich 555460-M

EHop-016 Sigma-Aldrich SML0526-5MG

Rho/Rac activator I Cytoskeleton #CN04

(Continued on next page)
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Critical commercial assays

Proteome Profiler Mouse Cytokine Array Kit R&D Systems ARY006

Mouse IL-6 ELISA assays Invitrogen, Thermo Fisher KMC0061

Mouse IL-1b ELISA assays Invitrogen, Thermo Fisher BMS6002

Mouse mouse TNF-a Invitrogen, Thermo Fisher BMS607-3

RhoA G-LISA assay Cytoskeleton Bk124

Rac1 G-LISA assay Cytoskeleton Bk126

NEB Next Ultra RNA library prep kit for

Illumina

NEB E7530S

PIP3 ELISA Kit Echelon bioscience K-2500S

Total Phosphatidic Acid Assay Kit Cell Biolabs, INC MET-5019

Free Fatty Assay Kit Sigma-Aldrich MAK044-1KT

Deposited data

RNAseq data ncbi accession number This study PRJNA777287; https://www.ncbi.nlm.nih.

gov/sra/PRJNA77728

Experimental models: Cell lines

Drosophila melanogaster S2R+ DGRC Stock Number: 150

Drosophila melanogaster Pex1 mutant

S2R+

This study N/A

Mouse: Bone marrow derived

macrophages from Sw129-Pxmp3tm1Plf-/-

Mutant Mouse Resource and Research

Centre (MMRRC) supported by the NIH

Faust and Hatten, 1997

Mouse: Bone marrow derived

macrophages from Sw129-Pxmp3tm1Plf-/+

MMRRC Faust and Hatten, 1997

Experimental models: Organisms/strains

Drosophila melanogaster: RNAI lines y1 v1;

P{TRiP.HMC04009}attP40

Bloomington Drosophila Stock Center #55322

W1118 King-Jones, U of A

Di Cara et al., 2015

N/A

hml-GAL4, UAS-GFP, Dpt-GFP Foley, U of A N/A

P{y[+t7.7] v[+t1.8]=TRiP.JF02912}attP2 Bloomington Drosophila Stock Center 28075

P{Ubi-GAL4.U}2/CyO Bloomington Drosophila Stock Center 32551

P{UAS-Rho1.N19}2.1 Bloomington Drosophila Stock Center 7328

P{UAS-Rho1.V14.E40L}4 Bloomington Drosophila Stock Center 7332

P{UAS-Rac1.N17}1 Bloomington Drosophila Stock Center 6292

P{w[+mC]=UAS-Rac1.V12 Bloomington Drosophila Stock Center 6291

M{w[+mC]=UAS-hDGK.}ZH-86Fb Bloomington Drosophila Stock Center 65800

UAS-Upd3-GFP Harrison, University of Kentucky

Harrison et al., 1998

N/A

Act5C-GAL4/CyO King-Jones, U of A

Di Cara et al., 2015

N/A

UAS-FOXO King-Jones, U of A

Di Cara et al., 2015

N/A

UAS-GFP King-Jones, U of A

Di Cara et al., 2015

N/A

129S6.129-Pex2tm1Plf/Mmmh Mutant Mouse Resource and Research

Centre

Faust and Hatten, 1997

N/A

Swiss Webster Charles River 024

Oligonucleotides

see Table S4 N/A

(Continued on next page)
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REAGENT or RESOURCE SOURCE IDENTIFIER

Recombinant DNA

pAHWRhoIN19 Fehon, University of Chicago Neisch et al., 2010

pAHWRhoIV14 Fehon, University of Chicago Neisch et al., 2010

and pAFW Rac1V12 Fehon, University of Chicago Neisch et al., 2010

pAGW-GRP1-GFP This study N/A

pAW- Lact C2-GFP This study N/A

pAW-PABD-RFP This study N/A

pAW-Rok This study N/A

pAW- PI3K92E This study N/A

pAW- CdsA This study N/A

pAW-Rho GAP p190 This study N/A

Software and algorithms

IDEAS software Millipore N/A

Imaris 8.3.1 Bitmap N/A

MegaView III Soft Imaging System Olympus N/A

FIJI/imageJ software Schneider et al., 2012 https://imagej.nih.gov/ij/

GraphPad 6 Prism N/A

HISAT2, StringTie, Ballgown and Deseq2

pipeline

NA Pertea et al., 2016

Cytoscape NA Reimand et al., 2019

Icy Bioimage BioImage Analysis Lab at Institut Pasteur http://icy.bioimageanalysis.org

FloJo BD N/A

Zeiss Zen lite Black & lite Blue Zeiss https://www.zeiss.com/microscopy/int/

products/microscope-software/zen-lite.

html?vaURL=www.zeiss.com/zen-lite

Other

Double strand RNA library Rnai-UCSF Stroschein-Stevenson et al., 2006
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RESOURCE AVAILABILITY

Lead contact
Further information and requests for resources and reagents should be directed to and will be fulfilled by the lead contact, Francesca

Di Cara (dicara@dal.ca).

Materials availability
d Plasmids made in this study are available from the lead contact upon request.

d The cell lines made in this study are available from the lead contact upon request.

d No new mouse or Drosophila line was made in this study.

Data and code availability
d RNA-seq data have been deposited at GEO and are publicly available as of the date of publication. Accession numbers are

listed in the key resources table. Microscopy data reported in this paper will be shared by the lead contact upon request.

d Any additional information required to reanalyze the data reported in this paper is available from the lead contact upon request.

d This paper does not report original code.
EXPERIMENTAL MODEL AND SUBJECT DETAILS

Any additional information required to reanalyze the data reported in this paper is available from the lead contact upon request.

Fly cell culture
S2R+ cells (Yanagawa et al., 1998) were obtained from the Drosophila Genomics Resource Center. Pex1 S2 cells were made using

S2R+ cells. Pex1 S2 cells expressing GFP-SKL were made using S2 cells expressing GFP-SKL, a kind gift from Dr. Ronald Vale,
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University of California San Francisco (Kural et al., 2005). All cells were grown in SFM4 Insect Cell Culture Medium (GE Biosciences)

supplemented with 50 U penicillin/mL and 50 mg streptomycin sulfate/mL. CRISPR/Cas9-derived Pex1 S2 cell lines were made as

described previously (Bassett et al., 2014). The guide RNA sequences cloned to target the Pex1 gene are 5’-TTCGATCCGGTCG-

CATTGATCGCTTGG and 5’-AACCCAAGCGATCAATGCGACCGGAT.

All S2 cell lines were derived from Drosophila melanogastermale embryos, according to protocols from the Drosophila Genomics

Resource Center (DGRC). Indel mutations in the genomic DNA of pre-selected clones were confirmed by fragment length analysis of

the amplified locus that was targeted byPex1 sgRNA.We used double-stranded RNA-mediated RNA interference (dsRNAi) to gener-

ated cells depleted of each gene of interest, including Pex5-i cells that have defects in peroxisome biogenesis and function and were

used in the transcriptomic and lipidomic analyses. All dsRNA interference treatments of cell cultures were done using the Drosophila

RNA interference library and protocol described previously (Stroschein-Stevenson et al., 2006). Gene depletions were verified by

qRT-PCR to verify the strength of each relevant double-stranded RNA (Figures S7G and S7H).

Fly stocks, husbandry and microinjection
Pex5 dsRNA-expressing lines y1 v1; P{TRiP.HMC04009}attP40 and w1118; P{GD14972}v42332 were from the Bloomington

Drosophila Stock Center (BDSC). The CdsA dsRNA-expressing line P{y[+t7.7] v[+t1.8]=TRiP.JF02912}attP2 was from the Vienna

Drosophila Resource Center. The ubiquitous driver line P{Ubi-GAL4.U}2/CyO (32551) and the cDNA expressing lines P{UAS-

Rho1.N19}2.1(7328), P{UAS-Rho1.V14.E40L}4 (7332), P{UAS-Rac1.N17}1 (6292), P{w[+mC]=UAS-Rac1.V12} (6291) and M{w

[+mC]=UAS-hDGKG.HA}ZH-86Fb (65800) were from the BDSC. The line expressing UAS-Upd3-GFP was a gift from Dr. Douglas

Harrison, University of Kentucky (Harrison et al., 1998). The plasmatocyte-specific driver Hml-GAL4, UAS-GFP strain was a gift

from Dr. Edan Foley, University of Alberta (Parsons and Foley, 2013). The Act5C-GAL4/CyO, UAS-FOXO and UAS-GFP strains

were gifts from Dr. Kirst King-Jones, University of Alberta (Di Cara et al., 2015).

Drosophila strains were cultured at 25�C on standard BDSC cornmeal medium supplemented with soy powder. For oral infection,

flies were cultured on filter paper soaked in 5% sucrose or 5% sucrose containing Ecc15 (OD600 = 200) or E. coli (OD600 = 200). Flies

were transferred to fresh vials every 2 days, and the number of dead flies was determined daily.

For infection by microinjection, flies were microinjected into the thorax using 1-mm internal diameter, thin-walled glass needle

pulled with a P-97 Flaming/Brown micropipette puller (Sutter) mounted on a PV830 microinjector and needle positioner (World Pre-

cision Instruments). Each adult fly was injected with 4 nL of Ecc15 (OD600 = 200) or Pseudomonas entomophila (OD600 = 25) in phos-

phate buffered saline (PBS) or PBS alone (control). Survival experiments were done with a total of 200 flies for each group. Injected

flies were transferred to 29�C, and the number of dead flies was determined every 2 days.

To generate survival curves for flies with knock downs of Pex genes exclusively in plasmatocytes (Hml-driven knock down), adult

flies were anesthetized with CO2 and infected by being pricked in the thorax with a thin needle that had been dipped into bacterial

working solution. Survival experiments were done at 29�C with 20-30 flies for each group. Surviving flies were transferred daily to

fresh vials and counted.

For extraction of plasmatocytes from adults, anesthetized flies were cut into 3 parts with surgical forceps (Fine Science Tools, Du-

mont #55 Forceps) and allowed to bleed for 1 min into a glass dish filled with 100 mL of SFM4 Insect Cell Culture Medium containing

cOmpleteTM Protease Inhibitor Cocktail (Roche) to avoid coagulation. The cell suspension was filtered on 70-mmmicrocentrifuge fil-

ters and processed for immunofluorescence in an 8-chamber cover glass (Nunc).

All experiments were conducted using an equal number of 3-4 day-old male and female adult D. melanogaster flies.

Mammalian cells
Murine bone marrow-derived macrophages

Murine bone marrow-derived monocytes were extracted from male and female 1-day-old pups, differentiated to macrophages

(BMDMs) and treated as previously described (Geng et al., 2015).

Human peripheral blood mononuclear cells
Peripheral blood mononuclear cells (PBMCs) from 9-year-old healthy males and from aged-matched male patients affected by Ka-

wasaki Disease were provided by Dr. Beata Derfalvi, IWK Health Centre, Dalhousie University (IWK REB#: 1020232). Frozen cell

stocks were thawed and grown in RPMI medium (Gibco) supplemented with 10% heat-inactivated fetal bovine serum (HI FBS)

(Hyclone, Thermo Scientific), 2 mM L-glutamine (Gibco), 50 mM 2-mercaptoethanol, 50 U penicillin/mL, 50 mg streptomycin

sulfate/mL. PBMCswere grown in the absence or presence of 200 ng LPS from E. coliO55:B5 (Sigma-Aldrich)/mL or in the presence

of a proinflammatory cytokine cocktail (IL-6, IL-1b and TNFa, each at 10 mg/mL) for 24 h. Cells were harvested and stained for flow

cytometry analysis or immunofluorescence microscopy.

Human synovial fluid fibroblasts
Synovial fluid fibroblasts (SFFs) from 4-year old healthy females and from aged-matched female patients affected by Juvenile Idio-

pathic Arthritis were provided by Dr. Beata Derfalvi, IWK Health Centre, Dalhousie University (IWK REB#: 1020232). Frozen cell

stocks were thawed and grown in MEM-a (Gibco) medium supplemented with 20% HI FBS, 1 mM sodium pyruvate, 1X MEM
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NEAA (Gibco), 2 mM L-glutamine, 50 mM 2-mercaptoethanol, 50 U penicillin/mL, 50 mg streptomycin sulfate/mL. Cells were grown

for 24 h, harvested and processed for immunofluorescence microscopy.

Bacteria
mCherry-expressing E. coli was a kind gift of Dr. Stefan Pukatzki, University of Alberta (MacIntyre et al., 2010). The bacteria were

grown in LB broth at 37�C for 16 h. Ecc15was a kind gift of Dr. Edan Foley, University of Alberta. The bacteria were grown in LB broth

at 29�C for 24 h.P. entomophilawas a kind gift of Dr. Nicolas Buchon, Cornell University. The bacteria were grown in LB broth at 29�C
for 24 h.

Pex2 mutant mice
The Pex2 mutant mouse strain used was 129S6.129-Pex2tm1Plf/Mmmh (null allele) (Faust and Hatten, 1997) and was obtained from

the Mutant Mouse Resource & Research Centers (MMRRC) supported by the National Institutes of Health. The mice used for the

experiments reported herein were Pex2+/+, Pex2-/- and Pex2+/-. Homozygous null mutants showed no Pex2 transcript and no

Pex2 protein. Homozygous null mutants in the congenic strain 129S6.129-Pex2tm1Plf +/- showed variable embryonic lethality, starting

at �E11. Approximately 20% of homozygous null mutants survived to birth but were hypotonic, did not feed, and died on the day of

birth. Homozygous null mutant mice that survived into the postnatal period were obtained by mating congenic 129S6.129-

Pex2tm1Plf +/- mice with wild-type Swiss Webster strain mice. F1-Pxmp3tm1Plf+/- hybrids (designated Sw129) were then intercrossed

to obtain Sw129-Pxmp3tm1Plf-/- (indicated in the text as Pex2-/-) mice.

Colonies were maintained as stable inbred lines in the SwissWebster and 129SVEV backgrounds under approved animal protocol

#19-002, abiding by the standards of the Canadian Council on Animal Care.

METHOD DETAILS

Reagents
Mouse antibody to peroxisomal catalase (ab16771), and Alexa Fluor 488-conjugated and Alexa Fluor 555-conjugated donkey anti-

mouse or donkey anti-rabbit secondary antibodies were fromAbcam. Rabbit anti-SKL antibodies have been described (Szilard et al.,

1995). Antibody to Rho1 (p1D9) was developed by Dr. Susan Parkhurst, Fred Hutchison Cancer Research Center, and was obtained

from the Developmental Studies Hybridoma Bank. Rat antibody to hemagglutinin protein (HA), clone 3F10, was from Roche. Mouse

anti-PIP2 antibody (ADI-915-062-100) was from Enzo. Mouse monoclonal antibody (F1804) to anti-Flag M2 antibody was from

Sigma-Aldrich. Mouse antibody to a-tubulin (T5168) was from Sigma-Aldrich. Rabbit anti-FOXO antibody (ab1959770) was from

Abcam.

Cy5 fluorescently labeled anti-CD11b (M1/70) or anti-F4/80 (BM8) antibodies were from BioLegend. Rabbit antibody to Pex2

(22163-i-AP) was from Proteintech. Mouse fluorescently labeled antibodies to CD3 (Clone OKT3, Cat. no. 317352) and CD4 (Clone

OKT4, Cat. no. 317438) were fromBioLegend. Mouse fluorescently labeled antibodies to CD19 (Clone HIB19, Cat. no 302240), CD14

(CloneM4P9, Cat. no. 566466), CD8 (Clone SK1, Cat. no. 563919), CD56 (Clone NCAM16.2, Cat. no. 565139) IL-6 (CloneMP5-20F3)

and TNF-a (Clone MP6-XT22) were from BD Biosciences. Fluorescently labeled mouse antibody CD8a AF 647 (Clone 53-6.7) was

from eBioscience. Fluorescently labeled mouse antibodies H2Kb (Clone AF6-88.5) and CD11c (Clone N418) were from BioLegend.

Fluorescently labeled antibody I-A/I-E (Clone M5/114.15.2) was from Becton Dickinson.

Macrophage treatment with Rho GTPase inhibitors and activator
MurineWT and Pex2-/- BMDMs were treated before LPS stimulation with 40 mMRhoA inhibitor, Rhosin (Merck), or GTPase inhibitor,

EHop-016 (Sigma-Aldrich), for 40 min, and tested for GTPase activation, cytoskeleton rearrangement, or cytokine secretion by

G-LISA, immunofluorescence microscopy, or ELISA, respectively. Murine WT and Pex2-/- BMDMs were treated before LPS-stimu-

lation with 5 mg Rho/Rac activator I (CN04, Cytoskeleton, Inc.)/mL for 3 h and tested for cytoskeleton remodeling by immunofluores-

cence microscopy.

Treatment of murine BMDMs with fatty acids, phosphatidic acid, and niacin
Murine WT BMDMs were treated for 24 h with 2% Fatty Acid Supplement (Sigma-Aldrich, F7050) or with 50 mM phosphatidic acid

sodium salt (Sigma-Aldrich) for 1 h prior to stimulation with LPS. Cells were then analyzed for cytoskeleton remodeling by immuno-

fluorescence microscopy or cytokine secretion by ELISA. Pex2-/- BMDMs were treated with 100 mM niacin for 48 h prior to stimu-

lation with 100 ng LPS/mL. Cells were then analyzed for cytoskeleton remodeling by immunofluorescence microscopy or cytokine

secretion by ELISA.

Treatment of murine BMDMs with lipopolysaccharides, Pam3CSK4 and R848, and cytokine detection and
measurements
MurineWT and Pex2-/- BMDMs were plated at a density of 105 cells per well in 24-well plates. Half of the cells were stimulated for 9 h

with 100 ng LPS/mL, while the other half were left as unstimulated controls. Various cytokines were detected using the Proteome

Profiler Mouse Cytokine Array Kit, Panel A (R&D Systems, ARY006) following the manufacturer’s instructions. Secretion of selected
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proinflammatory cytokines (IL-6, IL1-b, TNF-a) was assessed using mouse IL-6, Mouse IL-1b and mouse TNF-a ELISA assays (In-

vitrogen, Thermo Fisher). To test for IL-1b secretion, BMDMswere treated with 5 mMATP for 1 h after 24 h of LPS treatment. WT and

Pex2-/- BMDMswere also stimulated for 24 hwith 10 ng Pam3CSK4 (InvivoGen)/mL or 100 ng R848 (InvivoGen)/mL and tested for IL-

6 secretion by ELISA assay. ELISA assays were carried out following the manufacturer’s instructions (Invitrogen, Thermo Fisher).

Constructs
Vectors pAHWRho1, pAHWRho1N19, pAHWRho1V14 and pAFWRac1V12 (Neisch et al., 2010) used to transfect S2 cells were kind

gifts of Richard Fehon, University of Chicago.

GRP1-GFPwasmade by first amplifying the cDNA sequence coding for the pleckstrin homology domain of the general receptor for

phosphoinositides, isoform 1, from nucleotides 779-1188 using primers GRP1-Forward 5’-CACCGGCCTCTGCTCGCCGTGCCC

GGG and GRP1-Reverse 5’-AAACTACAGCTGGCTCTCCTCCTCC. The amplified fragment was cloned into the pENTR/D-TOPO

donor vector (Thermo Fisher) and then transferred to the Drosophila Gateway destination vector, pAGW.

pLactC2-GFP was made by amplifying the Lact2-GFP fusion coding region using the primers EGFP-Forward 5’-CAACATGGT-

GAGCAAGGGCGAGGAGCTGTT and LactC2-Reverse 5’-GCAGACGAATTCCTAACAGCCCAGCAGCTCC from the vector pEG

FP-C1-LactC2 (Yeung et al., 2008), kindly donated by Sergio Grinstein, University of Toronto. The amplified fragment was cloned

into the pENTR/D-TOPO donor vector and then transferred to the destination vector, pAW.

A vector expressing red fluorescent protein (RFP) fused to a PA-binding domain (PABD-RFP) was made by amplification of the

sequence for the PA-binding domain from the SPO20 gene encoding Saccharomyces cerevisiae sporulation-specific protein 20

(ORF Clone: SPO20_OSi04016D_pcDNA3.1+/ C-(K)-DYK, GenEZ) using primers PABD-Forward 5’-CAACATGGACAATTGTTCAG-

GAAGCAGAA and PABD-Reverse 5’-AAAACTAGTCTTAGTGGCGTCATC. The amplified fragment was cloned in the pENTR/D-

TOPO donor vector and then transferred to the Drosophila Gateway destination vector, pARW.

The Drosophila Rock cDNA catalytic domain was amplified from genomic DNA extracted from transgenic fly P{UAS-Rok.CAT}7.1

expressing the sequence for the Rock catalytic domain underUAS control. The 1454-bp longRock coding regionwas amplified using

the primers Rock Forward 5’-CACCATGCCAGCTGGACGAGAAACTGT and Rock Reverse 5’-CTAGGAATTCGACGGCCGATGG.

The amplified fragment was cloned into the pENTR/D-TOPO donor vector and then transferred to the destination vector, pAW.

The Drosophila recombinant vector PI3K92E was made by amplification of the clone FMO08840 obtained from the Drosophila

Genomic Research Center (DGRC) using primers PI3K92E Forward 5’-CCACATGAACATGATGGACAACCG and PI3K92E Reverse

5’-TTACTGTTTGTTGTTTTTGGAGAAG. The amplified fragment was cloned into the pENTR/D-TOPO donor vector and then trans-

ferred to the destination vector, pAW.

The Drosophila Pis recombinant vector was made by amplification of cDNA clone RE35104 from the DGRC using primers Pis For-

ward 5’- CCACATGACAATTGCCGAGCACGATAAC and Pis Reverse 5’-AAATCACTCCACTTTCTTGCC. The amplified fragment was

cloned into the pENTR/D-TOPO donor vector and then transferred to the destination vector, pAW.

The Drosophila CdsA recombinant vector was generated by amplification of cDNA clone FI18858 obtained from the DGRC using

primers CdsA Forward 5’- CCACATGGCCGAAGTGCGACGCA and CdsA Reverse 5’-TTAGGTTAACATGTCGCCCAAG. The ampli-

fied fragment was cloned into the pENTR/D-TOPO donor vector and then transferred to the destination vector, pAW.

TheDrosophilaRhoGAPp190 recombinant vector wasmade by amplification of clone RE1088 using primers p190GAP Forward 5’-

ACCATGCGTCAGTTTAACATCTCG and p190GAP Reverse 5’-AAAGACCATGACAAAAGCATC. The amplified fragment was cloned

into the pENTR/D-TOPO donor vector and then transferred to the destination vector, pAGW, for expression of RhoGAPp190-GFP.

Assay for Rho GTPase activation
The amounts of activated (GTP-bound) RhoA and Rac1 were measured in resting, bacterially infected or LPS-stimulated cells by

G-LISA, an ELISA-based assay that quantifies the amount of the active GTP-bound form of Rac1 and Rho1, according to the man-

ufacturer’s protocol (Cytoskeleton). Briefly, cells were grown in 24-well plates at a density of 105 cells/well. Half of the wells were

stimulated with 20 ng LPS/mL (murine macrophages) or Ecc15 (S2 cells) for 20 min, while the other half were left as untreated con-

trols. Cells were then lysed in the buffers provided by the manufacturer, centrifuged to remove debris, and equivalent amounts of

supernatant were incubated in 96-well microtiter dishes precoated with probes that specifically recognize the activated forms of

RhoA and Rac1. Constitutively active forms of Rho proteins provided by the manufacturer were used as positive controls. After

incubating for 30 min, wells were washed and incubated with primary antibodies that recognize RhoA or Rac1, followed by an

HRP-conjugated secondary antibody. The amounts of activated RhoGTPase proteins were determined by the luminescence inten-

sity of the HRP reagent using a Spectramax 190 microplate reader (Molecular Devices).

Lipidomics
Lipid extraction, analysis, identification and quantification were performed at the Core Facility Metabolomics, Laboratory Genetic

Metabolic Diseases, University of Amsterdam, essentially as described (Herzog et al., 2016).

Heatmaps
Heatmaps of themost important lipid changes between different groups were generated by calculating the Z-score of each individual

sample in the screen, where Z = (X (value of the individual sample) - m (average of the row) / s (standard deviation of the row)).
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RNA-seq
For RNA-seq, 4 independent biological replicates of cells of the indicated genotype and under the indicated condition were analyzed.

Total RNA was extracted using TRIzol reagent (Thermo Fisher) and the Rneasy Micro Kit (Qiagen) and then depleted for rRNA using

RiboZero (Illumina). RNA quality was determined using the RNA 6000 Pico Kit (Agilent) and an Agilent 2100 Bioanalyzer. Libraries

were prepared using the NEBNext Ultra RNA Library Prep Kit for Illumina (New England Biolabs) and NEBNext Multiplex Oligos

for Illumina (Index primers). 2-nM libraries were analyzed using the MiSeq Reagent Kit V2 (500 cycles) (paired-end reads, 2 x 150

cycles) at The Applied Genomics Core (TAGC), University of Alberta. RNA-seq data were analyzed using the HISAT2, StringTie, Ball-

gown and Deseq2 pipeline, as reported previously (Pertea et al., 2016). Gene expression profile changes between control S2 cells

and Pex5-i cells under an indicated condition were analyzed using Gene Set Enrichment Analysis to identify biological processes,

cellular components, and KEGG pathways that were differentially regulated in the absence of functional peroxisomes. Data from

the Gene Set Enrichment Analysis were then visualized using GeneMANIA Force-Directed Layout of the Enrichment Map plugin in

Cytoscape to generate the gene interaction network (Reimand et al., 2019). The resulting networkmapwas curated to remove redun-

dant and uninformative nodes, resulting in a simplified network. The maps for each comparison were combined.

RNA extraction and qRT-PCR
Cells or adult flies were rinsed twice with PBS, transferred to TRIzol reagent, and snap-frozen in liquid nitrogen. Total RNA was ex-

tracted using the Rneasy Micro Kit, according to the supplied protocol. RNA was reverse transcribed using 1) the iScript cDNA Syn-

thesis Kit (Bio-Rad), and the synthesized cDNA was used for qPCR using the SYBR-Green PCRmaster mix (i-SYBR) (Bio-Rad) and a

CFX qPCR machine (Bio-Rad) or 2) an oligo-dT18 primer and SuperScript III Reverse Transcriptase (Thermo Fisher), and the synthe-

sized cDNA was used for q-PCR using the Maxima SYBR Green/ROX qPCR Master Mix (Thermo Fisher) and a QuantStudio 6 Flex

Real-Time PCR system (Applied Biosystems). Samples were normalized to rpl23 gene expression for Drosophila experiments or to

Hprt gene expression for mouse experiments using the 2-DDCTmethod (Livak and Schmittgen, 2001). Primer sequences used in qRT-

PCR are presented in Table S4.

Mitochondrial respiration rate
Mitochondrial oxygen consumption in both intact and permeabilized cells was measured at 25�C (Pesta and Gnaiger, 2012) using a

high-resolution respirometer (Oxygraph O2K, Oroboros Instruments, Innsbruck, Austria). Cells were counted by flow cytometry

(Attune NxT, Thermo Fisher) by standard forward scatter (FSC) and size scatter (SSC) approaches and then collected by centrifu-

gation at 250 x g for 5 min. The cell pellet was then resuspended in a respiration medium optimized for Drosophila consisting of

120 mM KCl, 5 mM KH2PO4, 3 mM HEPES, 1 mM EGTA, 1 mMMgCl2, 0.2% BSA, pH 7.2 (Pichaud et al., 2011; Simard et al., 2018)

at a concentration of 250,000 cells/mL. Cells (N = 3 for each cell line) were then transferred to the chambers of the oxygraph filled

with oxygen-saturated respiration medium. After stabilization of the signal, the routine respiration rate, which represents the mito-

chondrial oxygen consumption of intact cells with endogenous substrates, was measured (Pesta and Gnaiger, 2012). Titration of

digitonin was then done by steps of 5 mg/mL to permeabilize the plasma membrane of cells (optimal concentration of 20 mg/mL)

and to allow oxidative substrates to reach the mitochondria. Addition of pyruvate (10 mM), malate (2 mM), proline (10 mM), glycerol-

3-phosphate (15 mM) and ADP (5 mM) allowed coupling of the electron transport from complex I, proline dehydrogenase and mito-

chondrial glycerol-3-phosphate dehydrogenase to the phosphorylation of ADP to ATP, and measured the OXPHOS respiration

rate. This substrate mixture was optimized and reflects the main oxidative substrates used by Drosophila mitochondria (Simard

et al., 2018). Titration of FCCP (steps of 0.25 mM) was then done to evaluate the non-coupled respiration (ETS respiration rate),

which represents the electron transport system maximal capacity (optimal concentration of 0.75 mM). Subsequently, additions

of rotenone (0.5 mM) and antimycin A (2.5 mM) allowed the inhibition of complexes I and III and measured the residual oxygen

consumption due to non-mitochondrial oxidative side reactions (Pesta and Gnaiger, 2012), which was subtracted from the other

respiration rates. Finally, TMPD (0.5 mM) and ascorbate (2 mM) were injected to measure the maximal capacity of complex IV.

Auto-oxidation of TMPD was corrected after injection of sodium azide (100 mM) to inhibit complex IV. All respiration rates are pre-

sented as pmol of O2.s
-1.106 cells-1.

Bacterial burden and survival rate of adult flies
Bacterial burden of infected adult flies and survival rate of adult flies were determined as described (Di Cara et al., 2017).

Isolation of cell membranes
Cells were isolated in 0.25MSTKMbuffer (0.25M sucrose, 25mMHEPES-KOH, pH 7.4, 25mMKOAc, 5mMMgCl2, 0.1mMEDTA, 1

x Complete Protease Inhibitor (Roche), 1 mM DTT) and sonicated in a sonicator bath to yield lysates. Lysates were centrifuged at

1,000 x g for 10 min at 4�C. The supernatant from this first spin was centrifuged at 10,000 x g for 20 min at 4�C. The supernatant

from this second spin and containing fragmentedmembranes was then centrifuged at 100,000 x g at 4�C for 1 h. The resultant pellets

were resuspended in 0.25 M STKM and used for lipid assays.
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Quantification of FFAs, PA and PIP3
PIP3 quantification was done using the PIP3Mass ELISA Kit (Echelon Biosciences). PA quantification was done using the Total Phos-

phatidic Acid Assay Kit (Cell Biolabs). FFA quantification was done using the Free Fatty Assay Kit (Sigma). All assays were done

following the manufacturers’ protocols.

Lipid amounts were normalized to cell number or protein amount.

Immunofluorescence microscopy
Cells were fixed in 4%paraformaldehyde in PBS for 30min, and then incubated for 1 h at room temperature in 5%normal goat serum

in 1x PBS and for 16 h at 4�C with primary antibody at a 1:100 dilution in 5% normal goat serum in 1x PBS. Appropriate Alexa Fluor

secondary antibodies were then used at 1:1000 dilution in 5% normal goat serum, while Cy5 fluorescently labeled phalloidin was

added to stain the cytoskeleton. After 4 washes in PBST (PBS + 0.1% (v/v) Triton X-100), cells were mounted in DAPI Pro-Gold Anti-

fade Reagent (Thermo Fisher) and imaged using a 100x oil immersion objective (NA = 1.4) mounted on an AxioObserver M1 micro-

scope (Zeiss) or using a Zeiss AxioObserver LSM 880 Airyscan, 100x 1.4 oil plan-Apochromat lens. Alternatively, unmounted cells

were imaged while submerged in a Nunc 155411 chambered borosilicate cover glass chamber (Thermo Fisher) or glass cover glass

chamber (ibidi).

Live-cell imaging
Cells were imaged while submerged in a m-8 well glass bottom chambered cover glass chamber (ibidi). Images were captured every

min over 60 min using a Zeiss LSM 880 confocal microscope and a Plan-APOCHROMAT 100x/1.4 Oil DIC lens. Videos were pro-

cessed using Icy Bioimage analysis software (http://icy.bioimageanalysis.org).

Flow cytometry
Flow cytometry of human PBMCswas performed as follows. PBMCs removed of red blood cells by treatment with Ammonium-Chlo-

ride-Potassium (ACK) lysis buffer (8.02 g NH4Cl/L, 1.0 g KHCO3/L 37mgNa2EDTA$2H2O/L) were counted and resuspended in FACS

buffer (0.5% BSA in sterile, filtered PBS) prior to staining. PBMCs were first surface-stained for 30 min on ice with antibodies (1:100

dilution) targeted against human CD3, CD4, CD8, CD14, CD19 and CD56. Subsequently, PBMCs were stained intracellularly with

anti-SKL antibody (1:200 dilution). Post-acquisition, after gating out doublets and cell debris, PBMCs were separated as reported

previously (Cliff et al., 2019). PBMCs were first separated based on CD3 and CD14 expression to isolate the monocyte/macrophage

fraction. The CD3 positive cells were further subdivided into CD4- and CD8-expressing T-cells. CD3 and CD14 negative cells were

then subdivided into B-cells based onCD19 expression and into twoNK-cell subpopulations (bright and dim) based onCD56 expres-

sion. Presence of anti-SKL antibody signal was then determined for monocytes/macrophages, CD4 and CD8 positive T-cells, CD19

expressing B-cells, and CD56 dim and bright NK-cells.

Multi-spectral imaging flow cytometry (IFC)
To perform IFC, 1010 mCherry-expressing E. coli cells were added to 109 S2 cells, and the combined cells were incubated for 15 min

at 4�C to allow for E. coli cell-S2 cell contact and then incubated for 2 h at 25�C in SFM4-Insect Cell Culture Medium. DNA was de-

tected by staining with Hoechst 33342. Data were acquired on an ImageStream Imaging Flow Cytometer (Amnis) (Rieger et al., 2010).

Cells were analyzed post hoc.

Internalization assay
The number of mCherry+ S2 cells was determined for each population by comparing the percentage of cells with internalized

mCherry-E. coli to the percentage of cells with surface-boundmCherry-E. coli. Using IDEAS software (Millipore), a mask was created

to identify the eukaryotic cell membrane using the bright field signal for two sets of samples and cell tracker dye for two other sets of

samples. This allowed differentiation between internalized (degree of internalization greater than 0) and bound (degree of internali-

zation less than 0) mCherry particles in the x-y axes and in the z-axis.

QUANTIFICATION AND STATISTICAL ANALYSIS

Statistical analysis
Prism was used to generate graphs and quantify p values using statistical methods as indicated in the respective figure legends.

Tests, numbers of experiments, error bars and meaning of p values are indicated in each figure legend.

Quantification of cell area defined by phalloidin staining
Wemeasured the cell area defined by phalloidin staining for each cell in a region of interest. Cells falling in the defined pixel threshold

were counted as positive.

To determine the intensity of the defined cells within the image:

1) – Open image.
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File -> Open.
2) – Select image type.

Image -> type -> 8-bit

3) – Analysis

Analyze -> Set Measurements -> Check the boxes: area, perimeter and intensity

4) – Draw a region of interest:

Select rectangle -> select a region of interest (ROI) around a cell

5) – Analysis

Analyze -> Measure

6) Repeat 4 and 5 for every cell in a frame in each biological replicate for each genotype and under each condition.

Infected S2 cells with cortical cytoskeleton defects presented an area value between 20,000 and 50,000 pixels, while control S2

cells presented an area value between 60,000 and 200,000 pixels. Murinemacrophages with cytoskeleton defects presented an area

value between 40,000 and 250,000 pixels, while control murinemacrophages presented an area value between 270,000 and 400,000

pixels.

Quantification of signaling molecule location
Software used: Icy Bioimage Analyser (http://icy.bioimageanalysis.org/), Zeiss Zen lite Black & Zeiss Zen lite Blue (https://www.zeiss.

com/microscopy/int/products/microscope-software/zen-lite.html?vaURL=www.zeiss.com/zen-lite)

Heatmaps were generated by applying the following steps to each video:

1. Launch Icy and Open video.

Image/Sequence -> Open.

2. Choose the scene of interest.

3. Filter to remove noise

Processing -> Filtering -> Median filter (Input: Scene name, Type: 2D) -> Apply.

4. Export video for Zen formatting

Image/Sequence -> Rendering -> ARGB image.
Image/Sequence -> Save as (File type: AVI sequence)

5. Launch Zen black and Zen blue for Image Processing

Drag and drop exported video -> File -> Send to Zen- blue edition

6. Adjust histogram Intensity to the required preference for the channels

7. Dimension -> Drop down for Channel of interest -> LUT -> Rainbow

8. Export video with preferred dimension and frames/second

Processing ->Method -> Create Image Subset -> Parameters -> Select Channels, Time & Region of interest -> Apply

New window generates with applied settings -> Processing ->Method -> Movie Export -> Parameters -> Format (AVI uncom-

pressed) -> Mapping (2.5fps) -> Apply

Quantification of SKL-labeled puncta
The areas of individual puncta and the average number of puncta per cell were calculated using the spots function of FIJI/imageJ

software, applying the following steps to each image:

1 – Open image.

File -> Open.
2 – Filter to remove noise.

Process -> Filters -> Gaussian Blur.
3 – Subtract background.

Process -> Subtract Background.
(the box marked ‘‘Light Background’’ was unticked).

4 – Set measurements to use later for filtering the puncta.

Analyze -> Set Measurements .

Tick the boxes marked ‘‘Area’’ and ‘‘Shape Descriptors’’. Then click on the ‘‘OK’’ button.
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In this step, manually set in FIJI measurements to use as ‘‘filter’’ later in the workflow [which features to include/exclude in the

counting (area, shape descriptors, centroid, perimeter)].

5 – Threshold image.

Image -> Adjust -> Threshold.

Box labeled ‘‘Dark Background’’ is ticked. Adjust the sliders so that features are red-colored, but the rest of the image is not. Click

‘‘Apply’’ button. This will replace the grayscale image with an ‘‘8-bit binary image’’. All ‘‘red’’ pixels are converted to a value of ‘‘255’’,

while all non-red pixels will be given a value of ‘‘0’’.

6 – Fill in any holes in the nuclei.

Process -> Binary -> Fill Holes

7 – Separate ‘‘Touching’’ puncta.

Process -> Binary -> Watershed

8 – Perform the analysis.

Analyze -> Analyze Particles.

In this dialogue box, the algorithm starts to include or exclude puncta based on their attributes. ‘‘Size’’ smaller than 1 square pixel.

‘‘Circularity’’ set range: 200-1.

Rack surface overtime
e10 C
1) Channel2-Ch2: Thick the box: absolute intensity

2) Min = 441 at t 380
ell Reports 38, 110433, March 1, 2022


	Modulation of the cell membrane lipid milieu by peroxisomal β-oxidation induces Rho1 signaling to trigger inflammatory resp ...
	Introduction
	Results
	Changes in the profile of cellular lipids during infection require peroxisome metabolism
	Peroxisomes support metabolic responses to mediate immune signaling
	Pex1 mutant S2 cells show metabolic and immune defects observed in Pex5-i cells
	Peroxisome depletion affects the amounts and distributions of distinct glycerophospholipids
	PA accumulates at the cell membrane in Pex1 cells and causes cortical cytoskeleton defects
	FOXO responds to peroxisome depletion and contributes to DGK-mediated synthesis of PA in Pex1 cells
	Depletion of PS synthetic pathways also contributes to cytoskeleton defects in Pex1 cells
	Peroxisomal β-oxidation contributes to the cellular lipid metabolic response to infection
	Defects in peroxisomal metabolism but not mitochondrial metabolism result in cytoskeleton defects in S2 cells
	Elevated amounts of PA in the cell membrane alter the localization of Rho GTPase and prevent its activation in S2 cells
	Rho1 signaling in peroxisome-depleted S2 cells is inhibited by p190RhoGAP
	Peroxisome-dependent defects in Rho1 signaling decrease host survival of systemic infection
	Peroxisomes promote Rho1-mediated cytokine secretion by plasmatocytes in Drosophila
	Peroxisomal metabolism regulates Rho1-mediated cytokine secretion by murine macrophages
	Peroxisomal lipid metabolism is needed for proinflammatory responses from human peripheral blood mononuclear cells

	Discussion
	Limitation of the study

	Supplemental information
	Acknowledgments
	Author contributions
	Declaration of interests
	Acknowledgments
	References
	STAR★Methods
	Key resources table
	Resource availability
	Lead contact
	Materials availability
	Data and code availability

	Experimental model and subject details
	Fly cell culture
	Fly stocks, husbandry and microinjection
	Mammalian cells
	Murine bone marrow-derived macrophages

	Human peripheral blood mononuclear cells
	Human synovial fluid fibroblasts
	Bacteria
	Pex2 mutant mice

	Method details
	Reagents
	Macrophage treatment with Rho GTPase inhibitors and activator
	Treatment of murine BMDMs with fatty acids, phosphatidic acid, and niacin
	Treatment of murine BMDMs with lipopolysaccharides, Pam3CSK4 and R848, and cytokine detection and measurements
	Constructs
	Assay for Rho GTPase activation
	Lipidomics
	Heatmaps
	RNA-seq
	RNA extraction and qRT-PCR
	Mitochondrial respiration rate
	Bacterial burden and survival rate of adult flies
	Isolation of cell membranes
	Quantification of FFAs, PA and PIP3
	Immunofluorescence microscopy
	Live-cell imaging
	Flow cytometry
	Multi-spectral imaging flow cytometry (IFC)
	Internalization assay

	Quantification and statistical analysis
	Statistical analysis
	Quantification of cell area defined by phalloidin staining
	Quantification of signaling molecule location
	Quantification of SKL-labeled puncta




